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Notations Used in This Guide

Safety Symbols

The projector and its manuals use graphical symbols and labels to indicate content that tells you how to use the projector safely.

Read and carefully follow the instructions that are marked with these symbols and labels to avoid injury to persons or damage to property.

This symbol indicates information that, if ignored, could possibly result in personal injury or even death.

A\ Warning

This symbol indicates information that, if ignored, could possibly result in personal injury or physical damage due to incorrect handling.

A\ Caution

General Information Notations

. This label indicates procedures that may result in damage or injury if sufficient care is not taken.
Attention P Y 8 Y
‘ This label indicates additional information that may be useful to know.
[Button name] Indicates the name of the buttons on the remote control or the control panel.
Example: [Esc] button
Menu/Setting name Indicates projector menu and setting names.
Example:
Select the Image menu.
@ Image > Color Mode
» This label indicates links to the related pages.
- This label indicates the projector's current menu level.

» Related Links
* "Using the Manual to Search for Information" p.8



* "Getting the Latest Version of the Documents" p.9



Using the Manual to Search for Information

The PDF manual allows you to search for information you are looking for by
keyword, or jump directly to specific sections using the bookmarks. You can
also print only the pages you need. This section explains how to use a PDF
manual that has been opened in Adobe Reader X on your computer.

» Related Links

* "Searching by Keyword" p.8

* "Jumping Directly from Bookmarks" p.8
* "Printing Only the Pages You Need" p.8

Searching by Keyword

Click Edit > Advanced Search. Enter the keyword (text) for information you
want to find in the search window, and then click Search. Hits are displayed as a
list. Click one of the displayed hits to jump to that page.
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Jumping Directly from Bookmarks

Click a title to jump to that page. Click + or > to view the lower level titles in

that section. To return to the previous page, perform the following operation on
your keyboard.

* Windows: Hold down Alt, and then press <.

Printing Only the Pages You Need

You can extract and print only the pages you need. Click Print in the File menu,
and then specify the pages you want to print in Pages in Pages to Print.

* To specify a series of pages, enter a hyphen between the start page and the
end page.

Example: 20-25

* To specify pages that are not in series, divide the pages with commas.
Example: 5, 10, 15

Print *
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Loples EI = [C1Print in grayscale (black and white)

[l5ave mkitener (D)
Pages ta Print Camments & Farmns
O Document and Markups -
———— Susrimiarier Conertsty
@Poges [0

Seale: 9T%

.............

82721169 Inches

CEE

Page Sizing & Hamdling (D)
Sire Paster Muiple Enaklet



Getting the Latest Version of the Documents

You can get the latest version of the manuals and specifications on the Epson
Web site.

Visit epson.sn, and enter your model name.


http://epson.sn

Introduction to Your Projector

See these sections to learn more about your projector.

» Related Links
* "Projector Parts and Functions" p.11



Projector Parts and Functions

The following sections explain the projector parts and their functions. Name Function
» Related Links @ | Air exhaust vent Exhaust vent for air used to cool the projector internally.
* "Projector Parts - Front/Top" p.11 .
* "Projector Parts - Rear" p.12 /A\ Caution
* "Projector Parts - Base" p.12 While projecting, do not put your face or hands
* "Projector Parts - Control Panel" p.14 objects that may become warped or damaged
« "Proiector Parts - Remote Control” p.14 by heat near the vent. Hot air from the air
J P exhaust vent could cause burns, warping, or
accidents to occur.
Projector Parts - Front /Top @ |Lens Images are projected from here.
@ | Lens shutter Links to the projector's power on/off function, and
automatically opens and closes the shutter.
@ [Remote receiver Receives signals from the remote control.
@ | Front adjustable foot | When setup on a surface such as a desk, turn to extend
and retract to adjust the horizontal tilt.
@ | [Source] button Cycles through the sources.
@ |Power button/ Turns the projector on or off.
indicator ( (l) ) Lit when the projector is on.
© | Cable cover Cover for the rear interface ports section.
© | Air intake vent (air Takes in air to cool the projector internally.
filter)
(0 | Air filter cover Open to access the air filter.
() [Indicators Indicates the projector's status.
(» | Air intake vent Takes in air to cool the projector internally.

» Related Links
* "Projector Indicator Status" p.121



Projector Parts and Functions

* "Remote Control Operation" p.32 * "Projector Parts - Interface Ports" p.13
* "Air Filter and Vent Maintenance" p.109
* "Attaching and Removing the Cable Cover" p.29

Projector Parts - Base

Projector Parts - Rear
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Name Function
@ | Control panel Operates the projector.
0
- ° ° %

@ |Interface ports Connects cables for external devices. T T J
@ | Power inlet Connects the power cord to the projector. I
@ | Cable holder Pass a commercially available cable tie through here to

secure cables.

- - - - - - Name Function

@ | Security slot The security slot is compatible with the Microsaver

Security System manufactured by Kensington. @ | Front adjustable feet | When setup on a surface such as a desk, turn to extend

and retract to adjust the horizontal tilt.
@ | Remote receiver Receives signals from the remote control. )
@ | Ceiling mount fixing | Attach the optional ceiling mount here when suspending
» Related Links points (four points) the projector from a ceiling.

* "Installing a Security Cable" p.73



Projector Parts and Functions

Name Function

@) | Wire clamp fixing When you use the optional ceiling mount, fix the
point carabiner here to attach the safety wire and prevent the

projector from falling from the ceiling or wall.

@ | Rear foot Stabilizes the projector on a surface such as a desk.

@ |Screw holes for cable | Screw holes to fix the cable cover in place.
cover

@ | Air filter cover screws | Screws to fix the air filter cover in place.

» Related Links

"Installing the Safety Wire" p.21
"Adjusting the Projector's Tilt" p.42

Projector Parts - Interface Ports

T????

66?

port
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Name Function
@ |USB-A (5V===2.0A) [Connects to a streaming media player to power it.

Use to connect a USB memory device to save error and
operation log files.

It is also used for batch settings and firmware update.
Hereinafter referred to as the USB-A port.

Service port

This port is used for batch settings and firmware update.

Name Function
@ | Trigger Out port Connects with external devices such as motorized
screens.
@ |LAN port Connects a LAN cable to connect to a network.
@ | Opt.HDMI (300mA) | Connects the power supply port for the optical HDMI
port cable. However, connection for all the devices is not
guaranteed. Make sure to check if your device works
beforehand.
@ |HDMII1 port Inputs video signals from HDMI compatible video
equipment and computers.
This port is compatible with HDCP 2.3.
@ |HDMI2 (eARC/ARC) |[Inputs video signals from HDMI compatible video
port equipment and computers.
This port is compatible with HDCP 2.3.
This port is compatible with HDMI eARC/ARC.
@ [RS-232C port Connects an RS-232C cable to control the projector
from a computer. (You do not need to use this port
normally.)

» Related Links
"Projector Connections" p.24




Projector Parts and Functions

Projector Parts - Control Panel * "Focusing the Image with the Lens Button" p.49

Projector Parts - Remote Control

Menu Esc
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Name Function ?Ll_nk] L] L]

@ | [Menu] button (v=) [ Displays and closes the projector's menu. é Color [ Tmage )
Lens Mode Enh
@ | [Lens] button Adjusts the focus, size, and position of the projected
image.
@ | Arrow buttons Selects menu items while displaying the projector's

menu or help.

Displays the previously used Geometry Correction
screen.

@ | [Enter] button («J) Enters the current selection and moves to the next level @ ooy ) ([Tt ) (o2 )
while displaying the projector's menu or help.

@Frame Int] [RGBCMY] (Pattern @-

@ | [Esc] button (D) Stops the current function. (R e

Moves back to the previous menu level while displaying
the projector's menu.

EPSON
» Related Links
* "Adjusting the Menu Settings" p.81 \\ J

* "Resizing the Image with the Zoom Feature" p.48



Projector Parts and Functions

Name Function

(© | [Lensl]/[Lens2] Loads the lens position registered as Memoryl or
button Memory?2 in the Lens Position setting.

@ | [Esc] button Stops the current function.

Moves back to the previous menu level while displaying
the projector's menu.

Name Function

@ | [On] button Turns the projector on.

@ | [Standby] button Turns the projector off.

© | [(HDMI1]/[HDMI2] Switches the image source between the HDMI1 and

button HDMI2 (eARC/ARC) ports.

@ | (Information] button [ Displays the Information screen.

@ | [Light Output] button [ Displays the Light Output screen.

@ | Playback control Controls playback of the connected devices that support

buttons the HDMI CEC standard.

@ | [(HDMI Link] button [ Displays the HDMI Link screen.

© | [Lens] button Adjusts the focus, size, and position of the projected
image.

© | [Color Mode] button [ Displays the Color Mode screen.

([ | Arrow buttons Selects menu items while displaying the projector's
menu.

(@ | [Enter] button Enters the current selection and moves to the next level
while displaying the projector's menu.

(® | [Default] button Returns the selected setting to its default value.

(® | [Menu] button Displays and closes the projector's menu.

@ | [Memory] button Displays the Memory menu.

(® | [Frame Int] button Sets the strength for Frame Interpolation.

(@ | [RGBCMY] button Adjusts the hue, saturation, and brightness for each
RGBCMY color.

(» | [HDR] button Displays the Dynamic Range screen.

(@ | [Pattern] Displays the Test Pattern screen.

emitting area

@ | [Image Enh] button | Displays the Image Enhancement screen.

@ | [Fine/Fast] button Displays the Image Processing screen.

@ | [Aspect] button Displays the Aspect screen.

@ | [Blank] button Temporarily stops projection. To turn the image back
on, press this button again.

@ [Mumination button | When you press this button, the remote control buttons
light up for approximately 10 seconds. This is useful
when operating the remote control in the dark.

@ |Remote control light | Outputs remote control signals.

» Related Links
* "Selecting an Image Source" p.50

* "Adjusting the Menu Settings" p.81
* "Color Mode" p.53
* "Image Aspect Ratio" p.51

* "Resizing the Image with the Zoom Feature" p.48

* "Focusing the Image with the Lens Button" p.49

¢ "Shutting Off the Image Temporarily" p.67

* "HDMI Link Features" p.65

* "Displaying a Test Pattern" p.37

* "Setting Frame Interpolation” p.55

* "Adjusting the Light Source Brightness" p.56

* "Adjusting the Image Resolution" p.57

* "Adjusting the Hue, Saturation, and Brightness" p.62




Projector Parts and Functions

* "Saving Settings to Memory and Using Saved Settings " p.68



Setting Up the Projector

Follow the instructions in these sections to set up your projector.

» Related Links

* "Projector Placement” p.18

* "Installing the Safety Wire" p.21

* "Projector Connections" p.24

* "Wired Network Connection” p.27

* "Attaching and Removing the Cable Cover" p.29
* "Installing Batteries in the Remote Control" p.31



Projector Placement

You can place the projector on almost any flat surface to project an image. .
P e oA o > A\ Warning
You can also install the projector in a ceiling mount if you want to use it in
a fixed location. An optional ceiling mount is required when suspending the * You must install a ceiling mount when suspending the projector from a ceiling. If
projector from a ceiling. you do not install the projector correctly, it could fall and cause damage or injury.
Note the following points when selecting a projector location: * Do not use a'dheswes on the' ceiling 'mount'ﬁx.lng points to prevent the screws
from loosening, or use lubricants, oils, or similar substances on the projector; the

* Place the projector on a sturdy, level surface or install it using a compatible projector case may crack causing it to fall from its ceiling mount. This could cause

mount. serious injury to anyone under the ceiling mount and could damage the projector.

* Failure to install the ceiling mount and projector may cause the projector to fall.
After installing the specific Epson mount that supports your projector, make sure
you secure the mount to all of the projector's ceiling mount fixing points. Also,
secure the projector and the mounts using wire that is strong enough to hold their
weight.

» * Do not install the projector in a location subject to high levels of dust or humidity,
or in a location subject to smoke or steam. Otherwise, it could cause a fire
or electric shock to occur. The projector's case could also deteriorate and be

damaged causing the projector to fall from the mount.
Examples of environments that could cause the projector to fall due to case
* Leave plenty of space around and under the projector for ventilation, and do deterioration

not place it on top of or next to anything that could block the vents. * Locations subject to excessive smoke or airborne oil particles, such as factories
or kitchens

* Place the projector so it squarely faces the screen, not at an angle.
* Locations containing volatile solvents or chemicals, such as factories or
laboratories

* Locations where the projector could be subjected to detergents or chemicals,
such as factories or kitchens

¢ Locations in which aroma oils are often used, such as relaxation rooms

* Near devices that produce excessive smoke, airborne oil particles, or foam at
events




Projector Placement

A\ Warning Notes on Transporting

* Do not cover the projector's air intake or air exhaust vents. If the vents are There are many glass parts and precision components inside the projector. To
ewvaat, toe it smpains cold fssend earey i, prevent damage due to impacts when transporting, handle the projector as

* Do not use or store the projector in locations where it will be subject to dust or follows.

dirt. Otherwise, the quality of the projected image may decline. If the lens or air

* Remove any equipment connected to the projector.
filter gets dusty, it may result in a malfunction or fire. yequp pro)

* Do not install the projector on an unstable surface or in a location beyond the * Cer}ter the lens position .using the [Lens] button. If. you transPort the
weight specifications of the projector. Otherwise, it could fall or topple causing an projector when the lens is not centered, the lens shift mechanism may be
accident and injury. damaged.

* When installing the projector in a high position, take measures to prevent falling * Make sure the lens shutter is closed.
by using wires to ensure safety in an emergency, such as an earthquake, and to

prevent accidents. If it is not installed correctly, it could fall causing an accident When transporting the projector a long distance or as checked luggage, pack

it in a firm box with cushioning around it and mark the box "Fragile."

and injury.

* Do not install in locations where salt damage could occur, or in locations subject ¢ When. Shipping tbe projector for‘ repairs, plac‘e it in.its or igi.nal.packing
to corrosive gas such as sulphuric gas from hot springs. Otherwise, corrosion materials, if possible, or use equivalent materials with cushioning around the
could cause the projector to fall. It could also cause the projector to malfunction. projector. Mark the box "Fragile."

Attention

* If you are using the projector at altitudes above 1,500 m, set the High Altitude
Mode setting to On in the projector's Installation menu to ensure the projector's
internal temperature is regulated properly.

* Try not to setup the projector in locations subject to high humidity and dust, or in Projector Setup and Installation Options

locations subject to smoke from fires or tobacco smoke.

Epson shall not be liable for any damages incurred during transportation.

You can set up or install your projector in the following ways:

» Related Links Front/Rear
* "Notes on Transporting” p.19

* "Projector Setup and Installation Options" p.19
* "Projection Distance" p.20 @/



Projector Placement

Front Ceiling/Rear Ceiling

n Y

Select the correct Projection option in the projector's Installation menu
according to the installation method being used. If necessary, turn on the Inv
Direction Button setting in the projector's Operation menu.

» Related Links
* "Projection Modes" p.38

Projection Distance

The distance at which you place the projector from the screen determines the
approximate size of the image. The image size increases the farther the projector
is from the screen, but can vary depending on the zoom factor, aspect ratio, and
other settings.

See the Appendix for details about how far to place the projector from the
screen based on the size of the projected image.

\

* "Screen Size and Projection Distance" p.137




Installing the Safety Wire

You can install the safety wire to prevent the projector from falling from the Attach a carabiner to the hole on the ceiling mount, and tighten the
ceiling. carabiner lock.
A\ Warning

Be sure to use the safety wire provided with the Epson ceiling mount. The safety wire
is available as an optional Safety Wire Set ELPWROLI.

» Related Links
* "When Using the Ceiling Mount ELPMB22" p.21
* "When Using the Ceiling Mount ELPMB30" p.22

When Using the Ceiling Mount ELPMB22

You can attach a safety wire to your projector for increased safety as shown.

Before you start, make sure you have firmly installed the ELPMB22 ceiling Attach the wire clamp to another carabiner, and then use the screw to fix
mount on the projector and have the following items that are included in the the wire clamp to the wire clamp fixing point on the projector.
safety wire set:

* Safety wire x 1
* Carabiner x 2
* Wire clamp x 1

* Attaching screw (M4 x 10 mm) x 1

% For details on installing the ELPMB22, see the Ceiling Mount ELPMB22/
@ ELPMB23 Instruction Manual.




Installing the Safety Wire

B Loop the safety wire through the carabiner on the ceiling mount, and When Using the Ceiling Mount ELPMB30
attach both ends to the carabiner on the projector.

You can attach a safety wire to your projector for increased safety as shown.

Before you start, make sure you have firmly installed the projector plate for the
ELPMB30 ceiling mount on the projector and have the following items that are
included in the safety wire set:

* Safety wire x 1
* Carabiner x 2 (Only one carabiner is used for the ELPMB30.)
* Wire clamp x 1

* Attaching screw (M4 x 10 mm) x 1

For details on installing the ELPMB30, see the ELPMB30 User's Guide.

Attach the wire clamp to the carabiner, and then use the screw to fix the
wire clamp to the screw into the wire clamp fixing point on the projector.

» Related Links
* "Getting the Latest Version of the Documents" p.9



Installing the Safety Wire

Loop the safety wire through the hole in the ceiling mount, and then
attach both ends to the carabiner.

L) D ~— =
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» Related Links
* "Getting the Latest Version of the Documents" p.9



Projector Connections

See these sections to connect the projector to a variety of projection sources.

Attention

Check the shape and orientation of the connectors on any cable you plan to connect.
Do not force a connector into a port if it does not fit. The device or your projector
could be damaged or could malfunction.

See the Quick Reference for a list of cables supplied with your projector.

Purchase optional or commercially available cables when necessary.

» Related Links

* "Connecting to an HDMI Video Source" p.24

* "Connecting to a Computer for HDMI Video" p.25
* "Connecting to a Streaming Media Player" p.25

* "Connecting to External Devices" p.25

* "Getting the Latest Version of the Documents" p.9

Connecting to an HDMI Video Source

If your video source has an HDMI port, you can connect it to the projector
using an HDMI cable.

Attention

Do not turn on the video source before connecting it to the projector. Doing so could
damage the projector.

* If the port on the device you connect has an unusual shape, use the

cable supplied with the device or an optional cable to connect to the
projector.

* The cable differs depending on the output signal from the connected
video devices.

* Some video devices are capable of outputting different types of signals.
See your video device manual to confirm what type of signals can be
output.

* When sending 40 Gbps images such as 4K 120Hz, use an HDMI cable
(ultra-high speed). If you use an incompatible cable, images may not
be displayed correctly. If images are not displayed correctly, you may be
able to display them correctly by changing the EDID Mode setting in
the projector's Signal I/O menu.

@ Signal I/O > EDID > EDID (HDMI1) > EDID Mode
@ Signal I/O > EDID > EDID (HDMI2) > EDID Mode

n Connect the HDMI cable to your video source's HDMI output port.

a Connect the other end to one of the projector's HDMI ports.

If you are connecting an optical HDMI cable that has a power supply
USB cable, you must also connect the cable's USB power connector to the
Opt.HDMI (300mA) port.




Projector Connections

Connecting to a Computer for HDMI Video

If your computer has an HDMI port, you can connect it to the projector using
an HDMI cable.

n Connect the HDMI cable to your computer's HDMI output port.

a Connect the other end to one of the projector's HDMI ports.

If you are connecting an optical HDMI cable that has a power supply
USB cable, you must also connect the cable's USB power connector to the
Opt.HDMI (300mA) port.
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Connecting to a Streaming Media Player

You can connect your streaming media player to the projector's HDMI port. By
connecting the power supply USB cable, you can power the streaming media
player from the projector.

The connection method and operating environment for the streaming

media player vary depending on the model you are using. For details, see
the documentation supplied with your streaming media player; otherwise,
it may not operate properly.

n Connect your streaming media player to the projector's HDMI port.
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HDMI™ 2 (€ARC/ARC)

a Connect the power supply USB cable to the projector's USB-A port.

B Connect the other end to the streaming media player.
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Connecting to External Devices

Follow the instructions in these sections to connect external devices to the
projector.



Projector Connections

» Related Links

* "Connecting to an eARC/ARC Compatible AV System or External Speakers"
p-26

* "Connecting to a Trigger Out Port" p.26

Connecting to an eARC/ARC Compatible AV System or External
Speakers

If your AV system or speakers, such as a sound bar, has an HDMI port, you can
connect them to the projector using an HDMI cable (with Ethernet) to output
audio to these devices.

* When the AV System is connected to the projector, set HDMI Link to
On.

@ Signal I/O > HDMI Link > HDMI Link

* See the Supplemental A/V Support Specification for eARC/ARC audio
supported formats.

n Connect the HDMI cable to your AV system's or speakers' HDMI output
port (eARC/ARC compatible).

a Connect the other end to the projector's HDMI2 (eARC/ARC) port.
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Make any necessary settings on the connected AV system. See your
device's documentation for more information.

» Related Links
* "Getting the Latest Version of the Documents" p.9

Connecting to a Trigger Out Port

You can connect your projector to external devices such as motorized screens
that support a trigger signal. When active, a 12V (200 mA maximum) signal is
sent to the connected device while the projector is powered on.

Connect a 3.5 mm stereo mini-jack cable to the external device's
trigger port. See the documentation supplied with the device for more
information.

g Connect the other end to the projector's Trigger Out port.
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B Set the Trigger Out setting in the projector's Operation menu.



Wired Network Connection

You can monitor and control your projector, over a network. Selecting Wired Network Settings
To perform these operations, connect the projector to your network, and then
set up your projector and computer. Before you can use the projector on your network, you need to select network

settings on the projector.

% If the Web Control Password has not been set, a screen prompting you to
$ set a password is displayed when you save the network settings. Follow the $ Make sure you already connected the projector to your wired network

on-screen instructions to set the password. using the LAN port.

» Related Links
* "Connecting to a Wired Network" p.27 n Press the [Menu] button, select the Network menu, and press [Enter].

* "Selecting Wired Network Settings" p.27

Color Uniformity
Log Save Destination USB and Internal Memory

Batch Setup Range

Connecting to a Wired Network Language & Engish
Information
To connect the projector to a wired local area network (LAN), use a 100Base-TX Pispiaysiatu

.. Reset M, t Setti
or 10Base-T network cable. To ensure proper data transmission, use a Category S

5 shielded cable or better.

Network

Wired LAN Info.

. Network Settings
Connect one end of the network cable to your network hub, switch, or

router.

Reset Network Settings
Memory
Image

Lens Position

g Connect the other end of the cable to the projector's LAN port.
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Reset Memory Settings

Initial/all Settings

Reset All

Firmware Update

a Select Network Settings and press [Enter].

To identify the projector over the network, select Projector Name and
enter a name up to 16 alphanumeric characters long.



Wired Network Connection

a Select the Wired LAN menu and press [Enter].

[ Wired LAN ] Return
IP Settings
IP Address Display On

B Assign the IP settings for your network as necessary.

¢ If your network assigns addresses automatically, select IP Settings to set
the DHCP setting to On.

* If you must set addresses manually, select IP Settings to set the DHCP
setting to Off, and then enter the projector's IP Address, Subnet Mask,
and Gateway Address as necessary.

To prevent the IP address from being displayed on the network
information screen, set the IP Address Display setting to Off.

FAl When you finish selecting settings, go back to the Network Settings
screen, select Set, and follow the on-screen instructions to save your
settings and exit the menus.

If the Web Control Password has not been set, a screen prompting

you to set a password is displayed when you save the network
settings. Follow the on-screen instructions to set the password.

» Related Links
* "Network Menu - Network Settings Menu" p.97



Attaching and Removing the Cable Cover

You can attach the cable cover that came with your projector to hide the Place the cable cover on the projector as shown, guiding the cables
attached cables from view. through the notch on the base of the cable cover.

n Turn the projector upside down.

Pass a commercially available cable tie through the cable holder and tie
the cables together.

Attach the cable cover by lifting it up slightly, and then tilting

it down so that the cable cover screws fit into the holes on the
projector.

A\ Caution

Do not bundle the power cord to the other cables. Otherwise, a fire may occur.



Attaching and Removing the Cable Cover

a Tighten the cable cover screws.

To remove the cover, loosen the cover screws and pull the cover off of the
projector.



Installing Batteries in the Remote Control

The remote control uses the two AA batteries that came with the projector. B Insert the batteries with the + and - ends facing as shown.

Attention
Make sure you read the Safety Instructions before handling the batteries.

AA manganese or alkaline batteries.

Replace the batteries as soon as they run out. The remote control uses two

n Remove the battery cover as shown.

(\L\x ,
L AN A Warning

Check the positions of the (+) and (-) marks inside the battery holder to
ensure the batteries are inserted the correct way. If the batteries are not used

correctly, they could explode or leak causing a fire, injury, or damage to the
product.

ﬂ Replace the battery cover and press it down until it clicks into place.

g Remove the old batteries, if necessary.

Dispose of used batteries according to local regulations.

» Related Links
* "Remote Control Operation" p.32



Installing Batteries in the Remote Control

Remote Control Operation

The remote control lets you control the projector from almost anywhere in the
room.

Make sure that you aim the remote control at the projector's receivers within the
distance and angles listed here.

* Avoid using the remote control in conditions with bright fluorescent

lights or in direct sunlight, or the projector may not respond to
commands. If you are not going to use the remote control for a long
time, remove the batteries.



Using Basic Projector Features

Follow the instructions in these sections to use your projector's basic features.

» Related Links

* "Turning On the Projector” p.34

* "Turning Off the Projector" p.36

* "Displaying a Test Pattern” p.37

* "Projection Modes" p.38

* "Adjusting the Image Position Using Lens Shift" p.40
* "Adjusting the Projector's Tilt" p.42

* "Image Shape" p.43

* "Resizing the Image with the Zoom Feature" p.48
* "Focusing the Image with the Lens Button" p.49

* "Selecting an Image Source" p.50

* "Image Aspect Ratio" p.51

* "Color Mode" p.53

* "Adjusting the Image Quality" p.54

* "Adjusting the Image Color" p.59



Turning On the Projector

Turn on the computer or video equipment you want to use after you turn on the %+ When you turn on the projector for the first time, the initial
projector. setup wizard is displayed. Make the focus, projection direction,
and language settings using the arrow and [Enter] buttons on the
Connect the power cord to the projector's power inlet and plug it into an control panel or remote control.
electrical outlet. * 'The projector's menu screens are displayed in black by default.

All of the instructions in this guide are explained using white
screens unless otherwise mentioned. You can change the color
theme using Menu Color in the projector's Display menu.

Try the following if you do not see a projected image.

* Turn on the connected computer or video device.

* Change the screen output from the computer when using a laptop computer.
* Insert a DVD or other video media, and press play (if necessary).

* Press the [Source] button on the projector.

¢ Press the button for the desired video source on the remote control.

A\ Warning

* Never look into the projector lens when the light source is on. This can damage

The projector enters standby mode. This indicates that the projector is your eyes and is especially dangerous for children.

receiving power, but is not yet turned on. ) . . )
* When turning on the projector at a distance using the remote control, make sure

_ there is no one looking into the lens.
Press the power button on the projector or the [On] button on the remote

control to turn on the projector * During projection, do not block the light from the projector with a book or other

objects. If the light from the projector is blocked, the area on which the light

The lens shutter opens and the status indicator flashes blue as the projector shines becomes hot which could cause it to melt, burn, or start a fire. Also, the
warms up. Once the projector is warmed up, the status indicator stops lens may get hot due to the reflected light which could cause the projector to
flashing and turns blue. malfunction. Turn off the projector to stop projection.

When the Direct Power On setting is set to On in the projector's

Operation menu, the projector turns on as soon as you plug it in. Note
that the projector also turns on automatically in cases such as recovery
from a power outage.



Turning On the Projector

» Related Links
* "Projector Feature Settings - Operation Menu" p.94



Turning Off the Projector

Turn off the projector after use.

* Turn off this product when it is not in use to prolong the life of the

projector. Light source life varies depending on the mode selected,
environmental conditions, and usage. Brightness decreases over time.

Press the power button on the projector or the [Standby] button on the
remote control.

The projector displays a shutdown confirmation screen.

Power Off?

Yes:Press @ button
No: Press any other button

a Press the power button on the projector or the [Standby] button on the
remote control again. (To leave it on, press any other button.)

The light source turns off, the lens shutter closes, and the status indicator
turns off.

To transport or store the projector, make sure all of the indicators on the
projector are off, and then unplug the power cord.



Displaying a Test Pattern

You can display a test pattern to adjust the projected image.

%  Some settings may not be available while displaying a test pattern. To
adjust these settings, project an image from a connected device.

n Turn on the projector.

a Press the [Pattern] button on the remote control.
Vo N

(Memory] (_Lenst ] ( Lens2 ]

[FrameInt] [RGBCMY] (Pattern |

menu.

You can also display a test pattern from the projector's Installation

B Select one of the following options:

* Display Position lets you display an internal pattern without
connecting a computer or video device.

* Color Isolation: R lets you display the red component of the projected
image.

* Color Isolation: G lets you display the green component of the
projected image.

* Color Isolation: B lets you display the blue component of the projected
image.

connected video source.

To display Color Isolation, you need to project an image from the

ﬂ Adjust the image as necessary.

B To cancel pattern display, press the [Pattern] button again.



Projection Modes

Depending on how you positioned the projector, you may need to change the a Press the [Menu] button on the control panel or remote control.
projection mode so your images project correctly.

* Front (default setting) lets you project from a table in front of the screen. B Select the Installation menu and press [Enter].

* Front/Ceiling flips the image over top-to-bottom to project upside-down
from a ceiling.

Installation

Test Pattern

* Rear flips the image horizontally to project from behind a translucent screen. Projection Front/Ceiling
o1e . . . . Geometry Correction Point Correction
* Rear/Ceiling flips the image over top-to-bottom and horizontally to project Blanking
from a ceiling behind a translucent screen. S Altdanisae =

Reset Installation Settings

» Related Links

Display
* "Changing the Projection Mode Using the Menus" p.38 No-signal Screen i
* "Projector Setup and Installation Options" p.19 Startup Screen on
Messages On
Menu Color White
. . . . Standby Confirmation On
Changing the Projection Mode Using the Menus o o 9

Reset Display Settings
You can change the projection mode to flip the image over top-to-bottom et

. . . Operation
and/or left-to-right using the projector menus.
Direct Power On off
Sleep Mode On ~

n Turn on the projector and display an image.

Select Projection and press [Enter].

B Select a projection mode and press [Enter].

[ Projection ] Return
Front
v/ Front/Ceiling
Rear

Rear/Ceiling



Projection Modes

B Press [Menu] or [Esc] to exit the menus.



Adjusting the Image Position Using Lens Shift

If you cannot install the projector directly in front of the screen, you can adjust Press the arrow buttons on the remote control or the control panel to
the position of the projected image using the lens shift feature. adjust the position of the projected image as necessary.

n Turn on the projector and display an image. H

a Press the [Lens] button on the control panel or remote control. L N

Menu Esc HDMI | vol Vol ! '
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@ @ [tens }{ e J{ %]
- e lme

72 AN

Press the [Lens] button repeatedly until Adjust Lens Shift appears on the * N ‘
screen. . ‘

@ Maximum horizontal range (H x 47%)
@ Maximum vertical range (V x 96%)
@ - the vertical height of the image

@ ¥ the horizontal width of the image

%  You cannot move the image to both the horizontal and vertical
maximum values.

When you are finished, press the [Esc] button on the control panel or
remote control.



Adjusting the Image Position Using Lens Shift

A\ Caution

* When transporting the projector, set the lens position to the center. If you
transport the projector when the lens is not centered, the lens shift mechanism
may be damaged.

* Do not put your finger in the moving parts of the projector's lens. Otherwise an
injury could occur.

@ * When adjusting the image height, position the image lower than where
you want it to be and then move it up. This will help prevent the image

from moving down after adjustment.
* The image is clearest when the lens is at the home position.

* To move the lens to the home position, press and hold the [Lens]
button on the control panel or remote control for three seconds.



Adjusting the Projector's Tilt

If the projected image is tilted horizontally (the left and right sides of the
projected image are at different heights) when the projector is setup on a table
or other flat surface, adjust the front feet so that both sides are level with each
other.

n Turn on the projector and display an image.

g If the image is tilted, rotate the front feet to adjust their height.

[ I
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@) Extend the front foot
@ Retract the front foot

You can adjust the position up to approximately 3 degrees.

If the projected image is unevenly rectangular, you need to adjust the image
shape.

» Related Links
* "Image Shape" p.43



Image Shape

You can project an even, rectangular image by placing the projector directly in a Press the [Menu] button on the control panel or remote control.
front of the center of the screen and keeping it level. If you place the projector at

an angle to the screen, or tilt it up or down, or oft to the side, you may need to

; B Select the Installation menu and press [Enter].
correct the image shape.

Installation

Test Pattern

After correction, your image is slightly smaller.

For the best quality images, we recommend adjusting the installation position of

. . . . Projection Front/Ceiling
the projector to achieve the correct image size and shape. ,
Geometry Correction Point Correction
. Blanking
M Related Links High Altitude Mode off

* "Correcting Image Shape with H/V Keystone" p.43
* "Correcting the Image Shape with Quick Corner" p.44

Reset Installation Settings

Display
* "Correcting Image Shape with Point Correction” p.46 No-signal Screen Blue
Startup Screen On
Messages On
. ° Menu Color White
Correcting Image Shape with H/V Keystone Sancy Contrmation o
Panel Alignment Off e

You can use the projector's H/V-Keystone setting to correct the shape of an

. . . Reset Display Settings
image that is unevenly rectangular on the sides.

Operation
Direct Power On Off
Sleep Mode On ~

> -

Select Geometry Correction and press [Enter].

. You see the Geometry Correction screen.
V—
(=]

Select H/V-Keystone and press [Enter]. Then select Yes and press [Enter]
You can correct images up to 30° right, left, up, or down. if necessary.
You see the H/V-Keystone adjustment screen:

% * You cannot combine with other correction methods.
[ Keystone ]

V-Keystone
n Turn on the projector and display an image. H-Keystone




Image Shape

B Use the arrow buttons on the projector or the remote control to select Correcting the Image Shape with Quick Corner
between vertical and horizontal keystone correction and to adjust the
image shape as necessary. You can use the projector's Quick Corner setting to correct the shape and size

« V-Keystone of an image that is unevenly rectangular.

|

n Turn on the projector and display an image.

When you are finished, press [Esc].
After correction, your image is slightly smaller.

%  You can also access the previously used Geometry Correction
screen by pressing the arrow buttons on the control panel.



Image Shape

g Press the [Menu] button on the control panel or remote control. B Select Quick Corner and press [Enter]. Then select Yes and press [Enter]
if necessary.
B Select the Installation menu and press [Enter]. You see the area selection screen.

Frequent Items Installation

Use the arrow buttons to select the area of the image you want to adjust.

Projection Front/Ceiling Then press [Enter]'

Geometry Correction Point Correction

Blanking [ Quick Corner ]
High Altitude Mode Off

tion
Reset Installation Settings
gement

Display
No-signal Screen Blue
Startup Screen On
Messages On
Menu Color White
Standby Confirmation On
Panel Alignment Off e

Reset Display Settings

Operation
Direct Power On Off
Sleep Mode On ~

Select Geometry Correction and press [Enter]. e

You see the Geometry Correction screen.

. % To reset the Quick Corner corrections, hold down [Esc] for about 2
[ Geometry Correction] Rt seconds while the area selection screen is displayed, and then select
Yes.
Quick Corner
Point Correction Press the arrow buttons to adjust the image shape as necessary.

To return to the area selection screen, press [Enter].



Image Shape

% Ifyou see this screen, you cannot adjust the shape any further in the
@ direction indicated by the gray triangle.

[ Quick Corner]

A

B Repeat steps 6 and 7 as needed to adjust any remaining corners.

g When you are finished, press [Esc].

The Geometry Correction setting is now set to Quick Corner in the projector's
Installation menu.

The next time you press the arrow buttons on the control panel, the area
selection screen is displayed.

Correcting Image Shape with Point Correction

You can use the projector's Point Correction setting to fine-tune the image
shape in portions of an image. The image is divided into a grid which allows you
to move intersection points on the grid as necessary to correct distortion.

Y
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n Turn on the projector and display an image.
a Press the [Menu] button on the control panel or remote control.

B Select the Installation menu and press [Enter].

Installation

Test Pattern

Projection Frant/Ceiling
Geometry Correction Point Correction
Blanking

High Altitude Mode Off

Reset Installation Settings

Display
No-signal Screen Blue
Startup Screen On
Messages On
Menu Color White
Standby Confirmation On
Panel Alignment Off e

Reset Display Settings
Operation

Direct Power On off

Sleep Mode On ~



Image Shape

Select Geometry Correction and press [Enter]. Use the arrow buttons to move to the point you want to correct, then press

You see the Geometry Correction screen. [Enter].

[ Geometry Correction ] Return

v H/V-Keystone -

S/

Quick Corner

Point Correction

/\V\
T
o

B Select Point Correction and press [Enter]. Then select Yes and press
[Enter] if necessary.

a Select Point Correction and press [Enter].
g Use the arrow buttons to correct distortion as necessary.

[ Point Correction ] Return
Quick Corner

Point Correction

Reset

To correct any remaining points, press [Esc] to return to the previous
For fine tuning, select Quick Corner to correct the shape and size screen, then repeat steps 8 and 9.

of an image roughly, and then select Point Correction to adjust

them precisely. m When you are finished, press [Esc].
Select the point number and press [Enter]. * To reset the Point Correction settings to their original positions, select
You see the grid on the projected image. Reset on the Point Correction screen.

If you want to change the grid color for visibility, press [Esc], then » Related Links

select a different Pattern Color setting in the Point Correction « "Correcting the Image Shape with Quick Corner" p.44
menu.



Resizing the Image with the Zoom Feature

You can adjust the size of the projected image using the zoom feature.

4—»‘

n Turn on the projector and display an image.

g Press the [Lens] button on the control panel or remote control.
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Press the [Lens] button repeatedly until Adjust Zoom is displayed on the
screen.

Press and hold the left or right arrow button on the control panel or
remote control to resize the image.

B When you are finished, press [Esc].



Focusing the Image with the Lens Button

You can adjust the sharpness of the projected image using the focus feature.

n Turn on the projector and display an image.
a Press the [Lens] button on the control panel or remote control.
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Press the [Lens] button repeatedly until Adjust Focus is displayed on the
screen.

Press and hold the left or right arrow button on the control panel or
remote control to focus the image.

B When you are finished, press [Esc].



Selecting an Image Source

When multiple image sources are connected to the projector, such as a
computer and DVD player, you can switch from one image source to the other.

n Make sure the connected image source you want to use is turned on.

For video image sources, insert a DVD or other video media and press
play.

B Do one of the following:

* Press the [Source] button on the projector until you select the source
you want.

* Press the button for the source you want on the remote control.

fOn Standby §
©

Source
(HDMI1]) (HDMI2] | ( Aspect ]

(information) (Light output] ~(Fine / Fast)




Image Aspect Ratio

The projector can display images in different width-to-height ratios called
aspect ratios. Normally, the input signal from your video source determines
the image's aspect ratio. However, you can change the aspect ratio for certain
images to fit your screen.

» Related Links
* "Changing the Image Aspect Ratio" p.51
* "Available Image Aspect Ratios" p.51

Changing the Image Aspect Ratio

You can change the aspect ratio of the displayed image.
n Turn on the projector and switch to the image source you want to use.

a Press the [Aspect] button on the remote control.

fOn Standby \
H® e

Source
(HDMI1) (HDMI2]|((Aspect )

(information] (tight output] (Fine / Fast]

A list of the available aspect ratios appears.

[ Aspect ] Return
Full
Zoom
Anamorphic Wide

Horiz. Squeeze

Select the aspect ratio you want to use for your input signal and press
[Enter].

Press [Menu] or [Esc] to exit the menus.

The available aspect ratio setting varies depending on the input signal.

Available Image Aspect Ratios

You can select the following image aspect ratios, depending on the input signal
from your image source.

$, * Note that using the aspect ratio function of the projector to reduce,
enlarge, or split the projected image for commercial purposes or for

public viewing may infringe upon the rights of the copyright holder of
that image based on copyright law.



Image Aspect Ratio

Aspect mode Description

Auto Automatically sets the aspect ratio according to the
input signal.

Full Displays images using the full size of the projection
area, but does not maintain the aspect ratio.

Zoom Displays images using the full width of the projection
area and maintains the aspect ratio of the image.

Anamorphic Wide Displays images that have a 2.40:1 aspect ratio when

using a commercially available anamorphic lens. Set the
Overscan setting in the projector's Signal I/O menu to
Off or the image will not display correctly.

Horiz. Squeeze

Displays images using the full width of the projection
area when using a commercially available anamorphic
lens.




Color Mode

The projector offers different color modes to provide optimum brightness,
contrast, and color for a variety of viewing environments and image types.
You can select the mode designed to match your image and environment, or
experiment with the available modes.

» Related Links
* "Changing the Color Mode" p.53
* "Available Color Modes" p.53

Changing the Color Mode

You can change the projector's Color Mode using the remote control to optimize
the image for your viewing environment.

n Turn on the projector and switch to the image source you want to use.

a Press the [Color Mode] button on the remote control to change the Color
Mode.

Volume | | Volume

‘ HDMI
Link

Color Image
’ Lens H Mode H Enh

7~ O\

A list of available Color Modes appears.

[ Color Mode ] Return
Vivid
Cinema
Natural

B Press the arrow buttons to select a color mode setting and press [Enter].

a Press [Menu] or [Esc] to exit the menus.

You can also set the Color Mode setting in the projector's Image menu.

Available Color Modes

You can set the projector to use these color modes, depending on the input
source you are using:

Color mode Description

Dynamic This is the brightest mode. Best for prioritizing
brightness.

Vivid Best for enjoying content with bright colors.

Cinema Best for enjoying content such as movies.

Natural Best for adjusting the image color.




Adjusting the Image Quality

You can fine-tune various aspects of the quality of your projected images. B Select the Image menu and press [Enter].

» Related Links
* "Adjusting the Sharpness" p.54

C le Dynamic

* "Setting Frame Interpolation” p.55 S =
* "Adjusting the Light Source Brightness" p.56 il 0

" . . . . " Color Saturation 50
* "Turning On Automatic Luminance Adjustment" p.56 - -
* "Adjusting the Image Resolution" p.57 STArbhes

White Balance

Frame Interpolation Off
Adjusting the Sharpness Dyl.ﬂamic C.nntrasl: off
Deinterlacing Off

You can adjust the outline of the image using the Sharpness setting. ol it

Scene Adaptive Gamma 5
Gamma 0
n Turn on the projector and switch to the image source you want to use. RGBCMY
Reset to Defaults
a Press the [Menu] button on the control panel or remote control. cOtics sl
Aspect Auto

Reset to Defaults

Select Sharpness and choose one of the following:

¢ Standard: enhances outlines for the entire image; adjusts the Thin Line
Enhancement and Thick Line Enhancement settings as well (defaults
to 5).

* Thin Line Enhancement: enhances details such as hair and clothing
patterns.

* Thick Line Enhancement: enhances backgrounds and larger elements.



Adjusting the Image Quality

B Press the left or right arrow button to adjust the sharpness of image.

[ Sharpness] Return
Standard 7 4 = | 2
Thin Line Enhancement 7 =

Thick Line Enhancement o =

Higher values make the image sharper and lower values make the image
softer.

B Press [Menu] or [Esc] to exit the menus.

Setting Frame Interpolation

You can use the projector's Frame Interpolation feature to smooth fast-moving
video by comparing consecutive image frames and inserting an intermediate
image frame between them.

Frame Interpolation is available when:
* Image Processing is set to Fine.

* Image Processing is set to Auto (ALLM), and the current input source is not
compatible with ALLM.

@ Signal I/O > Image Processing
* 4K 100/120Hz signals are not input.

n Turn on the projector and switch to the image source you want to use.

g Press the [Frame Int] button on the remote control.

(Memory) ( Lenst ] ( Lens2 ]

(Frament) (RGBCMY) ( Pattern )

B Select the level of interpolation and press [Enter].
[ Frame Interpolation ] Return

v Off
Low
Normal

High

ﬂ When you are finished, press the [Frame Int] button.

@ * If your resulting images contain noise, turn off the Frame
Interpolation setting.

* You can also set the Frame Interpolation setting in the projector's
Image menu.



Adjusting the Image Quality

Adjusting the Light Source Brightness

You can adjust the brightness of your projector's light source.
n Turn on the projector and switch to the image source you want to use.

a Press the [Light Output] button on the remote control.

fOn Standby \
H® e

Source
(HDMI1) (HDMI2]|((Aspect ]

(information) ~ (Light output) (Fine / Fast]

B Use the left and right arrow buttons to select the brightness.

[Image] Return

Light Output 100% L 4

ECO Normal

Press [Menu] or [Esc] to exit the menus.

You can also set the Light Output setting in the projector's Image menu.

Turning On Automatic Luminance Adjustment

You can turn on Dynamic Contrast to automatically optimize the image
luminance. This improves the image contrast based on the brightness of the
content you project.

n Turn on the projector and switch to the image source you want to use.
a Press the [Menu] button on the control panel or remote control.

B Select the Image menu and press [Enter].

C e Dynamic
Brightness 50
Contrast 50
Color Saturation 50
Tint 50
Sharpness
White Balance
Frame Interpolation Off
Dynamic Contrast Off
Deinterlacing Off
Image Enhancement
Scene Adaptive Gamma 5
Gamma 0
RGBCMY
Reset to Defaults

Source HDMIT
Aspect Auto

Reset to Defaults

n Select Dynamic Contrast and press [Enter].

B Choose one of the following options and press [Enter]:

* Normal for standard brightness adjustment.



Adjusting the Image Quality

* High Speed to adjust brightness as soon as the scene changes. a Press the [Image Enh] button on the remote control.

[ Dynamic Contrast ] Return ‘HDMI I ‘Volumel ‘Volumel
Link - +
High Speed
Normal ’ Lens H Voge H I?ﬁﬁel
=
/> 7N\ (\

B Press [Menu] or [Esc] to exit the menus.

B Select Image Preset Mode and press [Enter].

Adjusting the Image Resolution

You can adjust the resolution of the image to reproduce a clear image with an
emphatic texture and material feel.

Noise Reduction and MPEG Noise Reduction are available when:

¢ Image Processing is set to Fine.

[ Image Enhancement ] Return
* Image Processing is set to Auto (ALLM), and the current input source

is not compatible with ALLM.

Image Preset Mode Off ~

@ Signal I/O > Image Processing

n Turn on the projector and switch to the image source you want to use.




Adjusting the Image Quality

a Select the preset option and press [Enter]. a Press [Menu] or [Esc] to exit the menus.

[Image Preset Mode ] Retlin You can also set the Image Enhancement setting in the projector's Image

menu.
v Off

Preset 1
Preset 2
Preset 3
Preset 4

Preset 5

The following settings saved in the preset option are applied to the image.
* Noise Reduction

* MPEG Noise Reduction

* Super-resolution

* Auto Contrast Enhancement

B Adjust each setting in the projector's Image menu individually as
necessary.

¢ To reduce flickering in images, adjust the Noise Reduction setting.

* To reduce the noise or artifacts seen in MPEG video, adjust the MPEG
Noise Reduction setting.

* To reduce blurring appeared when projecting low resolution image,
adjust the Super-resolution setting.

¢ To create a clearer and sharper image by automatically adjusting the
contrast, adjust the Auto Contrast Enhancement setting.

The settings value in the preset option are overwritten.



Adjusting the Image Color

You can fine-tune various aspects of how colors are displayed in your projected

images.

» Related Links

* "Adjusting the Color Temperature" p.59

* "Adjusting the RGB Offset and Gain" p.60

* "Adjusting the Gamma" p.60

* "Adjusting the Hue, Saturation, and Brightness" p.62

Adjusting the Color Temperature

You can set the overall color tone by adjusting the Color Temp. setting if the
image is too bluish or reddish.

n Turn on the projector and switch to the image source you want to use.

g Press the [Menu] button on the control panel or remote control.

B Select the Image menu and press [Enter].

C le Dynamic
Brightness 50
Contrast 50
Color Saturation 50
Tint 50
Sharpness
White Balance
Frame Interpolation Off
Dynamic Contrast Off
Deinterlacing Off
Image Enhancement
Scene Adaptive Gamma 5
Gamma 0
RGBCMY
Reset to Defaults

Source HDMIT
Aspect Auto

Reset to Defaults

Select White Balance > Color Temp. and press [Enter].
p P

B Use the left and right arrow buttons to adjust the color tone of the image.
[ White Balance ] Return

Color Temp. 10 L 4§ —————— P H

Higher values tint the image blue and lower values tint the image red.

% The temperature range is from 3200 K to 10000 K (for Natural color
$ mode) or is from 0 to 13 (for other color modes).



Adjusting the Image Color

B Press [Menu] or [Esc] to exit the menus. B Do the following as necessary for each R (red), G (green), and B (blue):
¢ To adjust the brightness of dark areas, adjust the Offset setting.

* To adjust the brightness of bright areas, adjust the Gain setting.

Adjusting the RGB Offset and Gain

. . . o s Ret
You can adjust the brightness of dark and bright areas by adjusting the Offset [ Custom ] &
and Gain settings for individual image colors.
Offset R 50 4 4
n Turn on the projector and switch to the image source you want to use. CHELG 2
Offset B 50 _—
a Press the [Menu] button on the control panel or remote control. Gain R 50 —
Gain G 50 =
B Select the Image menu and press [Enter]. Gain B 50 _—
Image
oKy Roes gl Higher values make the image brighter and lower values make the image
Brightness 50 darker.
Contrast 50 )
Color Saturation 50 * In the Offset setting, shading for the dark areas is more vividly
Tint 50 expressed when you select a high value. When you select a low value,
Sharpness the image appears more full-bodied but shading for the dark areas is
e harder to distinguish.
Frame Interpolation Off
DAt Catrt o ¢ In the Gain setting, the bright areas become whiter and shading is lost
Deinterfacing off when you select a high value. When you select a low value, shading for
Image Enhancement the bright areas is more vividly expressed.
Scene Adaptive Gamma 5
S . @ Press [Menu] or [Esc] to exit the menus.
RGBCMY
Reset to Defaults
Source HOMI
= e Adjusting the Gamma

Reset to Defaults

You can correct differences in projected image colors that occur between
ﬂ Select White Balance > Custom and press [Enter]. different image sources by adjusting the Gamma setting.



Adjusting the Image Color

% To optimize the color tone according to the scene, and to obtain a more B Select and adjust the correction value.
$ vivid image, correct the image by adjusting the Scene Adaptive Gamma
setting. [Gamma] Return
2
n Turn on the projector and switch to the image source you want to use. 1
a Press the [Menu] button on the control panel or remote control. 1
)
B Select the Image menu and press [Enter]. Custom
Reset
Image
ri Dynamic
Brightness 50 .
P - When you select a smaller value, you can reduce the overall brightness of
ot fratan 5 the image to make the image sharper. When you select a larger value, the
it %0 dark areas of images become brighter, but the color saturation for lighter
SHaroness areas may become weaker.
White Balance
Frame Interpolation Off
Memory Dynamic Contrast Off
Initial/ Deinterlacing off
Image Enhancement
Scene Adaptive Gamma 5
Gamma 0
RGBCMY
Reset to Defaults
Source HDMI1
Aspect Auto

Reset to Defaults

6 If you want to make finer adjustments, select Custom and press [Enter].

Select Gamma and press [Enter].



Adjusting the Image Color

PAl Press the left or right arrow buttons to select the color tone you want to
adjust on the gamma adjustment graph. Then press the up or down arrow
button to adjust the value and press [Enter].

[Gamma]

Blinking area is the adjustment target.

g Press [Menu] or [Esc] to exit the menus.

Adjusting the Hue, Saturation, and Brightness

You can adjust the Hue, Saturation, and Brightness settings for individual image
colors.

n Turn on the projector and switch to the image source you want to use.

a Press the [RGBCMY] button on the remote control.

\

SRt

PN/

(Memory] [ Lenst ] ( Lens2 ]

(FrameInt] [RGBEMY] [ Pattern |

B Select the color to adjust, and press [Enter].

[ RGBCMY ] Return
Hue Saturation Brightness
G 1) e : ) S ——
B S — SORE——s S —
© 50 m— o) —— S0 —
M 50 =— 50 m— 50—
Y, 50— 50 — 50 s—

Do the following as necessary for each setting:

¢ To adjust the overall hue of the color, bluish - greenish - reddish, adjust
the Hue setting.

* To adjust the overall vividness of the color, adjust the Saturation

setting.



Adjusting the Image Color

* To adjust the overall color brightness of the color, adjust the Brightness

setting.
[R] Return
Hue 50 M 4 | 2
Saturation 50 _—
Brightness 50 ———

B Press [Menu] or [Esc] to exit the menus.

You can also set the RGBCMY setting in the projector's Image menu.



Adjusting Projector Features

Follow the instructions in these sections to use your projector's adjustment features.

» Related Links

* "HDMI Link Features" p.65

* "Shutting Off the Image Temporarily" p.67

* "Saving Settings to Memory and Using Saved Settings " p.68
* "Using Advanced Image Adjustment Features" p.70

* "Projector Security Features" p.72



HDMI Link Features

When an audio/video source that meets the HDMI CEC standard is connected
to the projector's HDMI port, you can use the projector's remote control to
control certain features of the linked device.

Example: Projector, audio/video system, and multi-media players connection

T

* Aslong as the connected device meets the HDMI CEC standard,

you can use the HDMI Link features even if the audio/video system
in-between does not meet the HDMI CEC standard.

* Up to 3 multi-media players that meet the HDMI CEC standard can be
connected at the same time.

» Related Links
* "Operating the Connected Devices Using the HDMI Link Features" p.65

Operating the Connected Devices Using the HDMI Link
Features

You can select the connected device that is available for HDMI Link and control
the selected device using the HDMI Link features.

$ * When you use the HDMI Link features, set the HDMI Link setting to
On in the projector's Signal I/O menu.

@ Signal I/O > HDMI Link > HDMI Link

* You must also configure the connected device. See the documentation
supplied with the device for more information.

* Some connected devices or functions of those devices may not
operate properly even if they meet the HDMI CEC standard. See the
documentation supplied with the device for more information.

* Use a cable that supports the HDMI standard.

n Press the [HDMI Link] button on the remote control.

Volume | | Volume

[ HDMI
Link

Color Image
‘ Lens H Mode H Enh

7~ N\

a Make sure HDMI Link is set to On.

B Select Device Connections and press [Enter].

[ HDMI Link ] Return
HDMI Link On ~

Power On Link Bidirectional

Power Off Link Off



HDMI Link Features

» Related Links
Select the device you want to control and project the image from, and « "Input Signal Settings - Signal I/O Menu" p.88

press [Enter].
* A linked device is indicated by a blue mark.
* The device name is left blank if it cannot be acquired.

B Press [Esc] to select the HDMI Link options as necessary.

* Power On Link lets you control what happens when you turn on the
projector or linked device.

$ ¢ Select PJ -> Device or Bidirectional to turn the linked device
on when the projector is turned on.

* Select Device -> PJ or Bidirectional to turn the projector on
when the linked device is turned on.

* Power Off Link lets you control whether linked devices are turned off
when the projector is turned off.

$ * Power Off Link only works when the connected device's CEC
power link function is enabled.

* Note that depending on the status of the connected device (for
example, if it is recording), the device may not be turned off.

B Press [HDMI Link] or [Esc] to exit the menus.

You can use the projector's remote control to control the linked device such as
playback, stop, or adjust the volume.

§ You can also set the HDMI Link setting in the projector's Signal 1/O

menu.



Shutting Off the Image Temporarily

You can temporarily turn off the projected image.

g

Press the [Blank] button on the remote control to temporarily stop
projection.

fOn Standby %
©

Source
(HDMI1) (HDMI2]|((Aspect ]

(information) (Light output] (Fine / Fast]

a To turn the image back on, press the [Blank] button again.

% Anyvideo action continues to run, however, so you cannot resume
projection at the point that you stopped it.



Saving Settings to Memory and Using Saved Settings

You can save customized settings and then select the saved settings whenever
you want to use them.

n Turn on the projector and display an image.

g Press the [Memory] button on the remote control.

(Memory] ( Lenst ] ( Lens2 ]

(FrameInt) [RGBCMY) ( Pattern )

The Memory menu is displayed.

Frequently Used Color Uniformity

Log Save Destination USB and Internal Memory
Batch Setup Range

Language & English

Information

Display Status

Reset Management Settings

Network
Wired LAN Info.
Network Settings
Reset Network Settings

Memory

Lens Position

Reset Memory Settings

Initial/All Settings

Reset All

Firmware Update

B Select one of the following options:

* Image lets you save your current settings for the projected image to the
projector's memory (10 memories with different names are available).

* You can save the following settings:

* Image menu settings for each color mode
* Blanking in the Installation menu

* The saved Color Mode is displayed on the right of the
memory name.

* Lens Position lets you save your current lens settings to the projector's
memory (10 memories with different names are available).

* You can save your current focus, zoom, and lens shift settings.

* You can load the saved settings from Memoryl or Memory2
by pressing the [Lens1] or [Lens2] buttons on the remote
control.

* Reset Memory Settings lets you reset all adjustment values on the
Memory menu to their default settings.

ﬂ Select one of the following options:

* Save Memory lets you save your current settings to the projector's
memory (10 memories with different names are available).

%% A memory name that has already been used is indicated by a
blue mark. Saving over a previously saved memory overwrites
the settings with your current settings.

* Load Memory lets you overwrite your current settings with saved
settings.



Saving Settings to Memory and Using Saved Settings

* Rename Memory lets you rename a saved memory.
* Erase Memory lets you erase the selected memory settings.

* Reset lets you reset the name and settings of a saved memory.

B Press [Menu] or [Esc] to exit the menus.

» Related Links

* "Image Quality Settings - Image Menu" p.85

* "Projector Installation Settings - Installation Menu" p.91
* "Image Quality Memory Settings - Memory Menu" p.100



Using Advanced Image Adjustment Features

Follow the instructions in these sections to use your projector's advanced image
adjustments.

» Related Links
* "Adjusting the Color Tone (Color Uniformity)" p.70

Adjusting the Color Tone (Color Uniformity)

You can use the Color Uniformity feature to manually adjust the color tone
balance in the projected image.

% The color tone may not be uniform even after adjusting the color
uniformity.

n Press the [Menu] button, select the Management menu, and press [Enter].

Management
Lej ck Off
Child Lock Off
Control Panel Lock off

Color Uniformity

Log Save Destination USB and Internal Memory
Batch Setup Range

Language @ English

Information

Display Status

Reset Management Settings
Network

Wired LAN Info.

Network Settings

Reset Network Settings
Memory

Image

Lens Position

a Select Color Uniformity and press [Enter].

B Select Color Uniformity again and press [Enter].

[ Color Uniformity ] Return

Color Uniformity Off e

Reset

n Select On and press [Enter]. Then press [Esc].
B Select Adjustment Level and press [Enter].

E Select the first adjustment level you want to adjust and press [Esc].
[ Color Uniformity ] Return

Adjustment Level 1M1/11 4 — p



Using Advanced Image Adjustment Features

%  There are eleven adjustment levels, from white to gray to black. You % The adjustment screen changes each time you press [Enter].
@ can adjust each level individually. @
Select Start Adjustments and press [Enter]. @ Press [Esc] to return to the area selection screen.
m Select the area of the image you want to adjust and press [Enter]. m Repeat the color adjustments to each area.
[ Color Uniformity ] Return

@ Return to step 5 and repeat all steps to adjust other levels.

Top Left

Top

@ When you are finished, press [Menu] to exit.
Top Right
Right
Bottom Right
Bottom
Bottom Left
Left
All

Adjust each area individually, then select All and adjust the entire

screen.

g Select Red, Green, or Blue and adjust the color tone, if necessary.

‘ [ Color Uniformity ] Top Left

Adjustment Level (i
Red 0 L | | 2
Green 0

Blue 0



Projector Security Features

You can secure your projector to deter theft or prevent unintended use by n Press the [Menu] button, select the Management menu, and press [Enter].
setting up the following security features:

Frequently Used M
* Lens lock security to disable zoom, focus, and lens shift operations by locking SRASTER

the [Lens] button. e i

Child Lock ofr
* Button lock security to block operation of the projector using the buttons on Control Panel Lock off

the projector. Color Uniformity

. X . . . Log Save Destination USB and Internal Memory

* Security cabling to physically secure the projector in place. o

Language @ English
» Related Links e
* "Locking the Projector's Lens Settings and Buttons" p.72 ) Display Status
° "Installing a Security Cable" p73 Initial/All Settings Reset Management Settings

Network
Wired LAN Info.

Locking the Projector's Lens Settings and Buttons Network Settings

Reset Network Settings

You can lock the buttons on the projector to prevent anyone from using the il
projector. You can also lock the zoom, focus, and lens shift settings to prevent Image
Lens Position

them from being adjusted.

a Select one of these lock types and press [Enter]:

* To lock the [Lens] button on the control panel and remote control to
prevent the zoom, focus, and lens shift settings from being changed,
select Lens Lock.

¢ To lock the projector's power button, select Child Lock.

To turn the projector on, you must press the power button for longer
than three seconds.

the power cord is connected if Direct Power On is set to On in
the projector's Operation menu.

Child Lock does not prevent the projector from turning on when

* To lock all buttons on the projector, select Control Panel Lock > Full
Lock.



Projector Security Features

%  You can use the remote control to control the projector even
when the buttons on the projector are locked.

¢ To lock all buttons on the projector except the power button, select
Control Panel Lock > Except for Power.

If you see a confirmation prompt, select Yes and press [Enter].

The Control Panel Lock setting is applied.

ﬂ Restart the projector to apply the Child Lock setting.

» Related Links

* "Unlocking the Projector's Buttons" p.73

* "Projector Feature Settings - Operation Menu" p.94

* "Projector Administration Settings - Management Menu" p.95

Unlocking the Projector's Buttons

If the projector's buttons have been locked, do one of the following to unlock
them.

* Set Lens Lock to Off in the projector's Management menu.
* Set Child Lock to Off in the projector's Management menu.

* Set Control Panel Lock to Off in the projector's Management menu.

%  You can also release Control Panel Lock by holding down the [Enter]
$ button on the control panel for seven seconds. A message is displayed
and the lock is released.

» Related Links
* "Projector Administration Settings - Management Menu" p.95

Installing a Security Cable

You can install the security cable on the projector to deter theft.

Use the security slot on the projector to attach a Kensington Microsaver
Security system.

%  For more details on the Microsaver Security System, visit the Kensington
Web site.

https://www.kensington.com/

-



https://www.kensington.com/

Monitoring and Controlling the Projector

Follow the instructions in these sections to monitor and control the projector over a network.

» Related Links

¢ "Controlling a Networked Projector Using a Web Browser" p.75
* "Using ESC/VP21 Commands " p.79

* "PJLink Support" p.80



Controlling a Networked Projector Using a Web Browser

Once you have connected your projector to your network, you can select
projector settings and control projection using a compatible Web browser. This
lets you access the projector remotely.

Make sure the computer and projector are connected to the network.
You can use the following Web browsers.

* Microsoft Edge (Windows)

e Safari (Mac, iOS)

While using the Web browser, do not connect using a proxy server. You
cannot select all of the projector menu settings or control all projector
functions using a Web browser.

If you set the Standby Mode setting to Communication On in the
projector's Operation menu, you can use a Web browser to select
settings and control projection even if the projector is in standby mode
(when the power is off).

n Make sure the projector is turned on.

Make sure your computer or device is connected to the same network as
the projector.

B Start your Web browser on the computer or device.

ﬂ Go to the Epson Web Control screen by entering the projector's IP
address into the browser's address box. When entering an IPv6 address,
wrap the address with [ and ].

You see the Epson Web Control screen.

—o .__9

@PT?

@ Controls the projector remotely.

@ Displays a test pattern.

@ Sets detailed projector settings.

@ Operates the projector's menu settings with your finger or mouse.



Controlling a Networked Projector Using a Web Browser

B Select the option corresponding to the projector function you want to Web Control Options
control.

Basic Control
$ You may need to log in to access some of the options on the Epson

Web Control screen. Set the following passwords first. Options on the Basic Control screen allow you to select the input source and

* To access the Basic Control option, you need to log in using control the projector.

EPSONREMOTE as the user name and your Remote Password.
(No password is set by default.)

— C
Set Basic Control to On in the projector's Network menu, and |
then set the password. O

@ Network > Network Settings > Projector Control > Basic

—

Control N —
* To access other options and save settings, you need to log in HDMIT ~ HDMI2

using EPSONWEB as the user name and your Web Control

Password. (No password is set by default.) — \ ‘) ‘ )))

Set the password in the projector's Network menu. N\

@ Network > Network Settings > Web Control Password

» Related Links
* "Web Control Options" p.76

@ Returns to the Epson Web Control screen.

@ Turns the projector on or off.

@ Selects the input source.

@ Turns the video and audio on or off temporarily.
@ Adjusts the speaker volume.

(@ Turns the projector off.



Controlling a Networked Projector Using a Web Browser

OSD Control Pad Test Pattern
Options on the OSD Control Pad screen allow you to display the projector's The Test Pattern screen displays the available test patterns and allow you to
setting menus and select them moving your finger or mouse on the pad. select to project it.

o_'.< Home 0SD Conirol Pad @‘_e 0—0< Test Patterm o @ 9
T — |

©

@ Returns to the Epson Web Control screen.

m"_e @ Displays available test patterns; select to project a test pattern.
@ Turns off test pattern display.

@ Returns to the Epson Web Control screen.

@ Displays the projector's setting menus.

@ Use your finger or mouse to navigate the menus.
@) Resets the selected setting to its default value.
@ Returns to the previous menu.

(@ Displays help topics.



Controlling a Networked Projector Using a Web Browser

Advanced %  You cannot change the following settings using Epson Web Control.
The Advanced screen allow you to select the projector's settings. $ « EDID
/_ + HDMI Link
image & he— ¢ Language
& Coor poce Dyname_~ | * Display Status
Brightness = = = =
£ = > [ = * Reset Network Settings
Cortest . ' * Firmware Update
< |8 - > = P
< - - > | =0
o 1= You can select the following settings only with Epson Web Control.
< J8 — | = * HTTP port (port number used for Web Control except for 80 [default],
Sharpres v 843, 3620, 3621, 3625, 3629, 4352, 4649, 5357, 10000, 10001, 41794)
Frame InLerpalmjon“ Normal v
Dynamic Contrast | .-'\.!.-J Highspeed () Nomal L_] off
o .
Mapping
Seene Adeptive Gamma s . .
( = B > |[
Gamma all o | .
Reset Image | [
SCHR : J]

@ Opens the menus.
@ Displays the menu name you selected.

@ Specifies the projector settings. (The available settings vary depending on your
projector model.)

@) Locks/unlocks the projector settings.
@ Updates the projector settings.



Using ESC/VP21 Commands

You can control the projector from an external device using ESC/VP21. In the following illustration, the projector side is shown on the left, and the
computer side on the right:

» Related Links
* "ESC/VP21 Command List" p.79 RS-232C

* "Cable Layouts" p.79 ©@O0®
yous'p © o) ©

ESC/VP21 Command List

When a command is input, the projector executes the command and returns a

:", and then accepts the next command.

GND 5 5 GND
If the command being processed terminates abnormally, an error message is

output and a ":" is returned. D 3 >< 3 TD
RD 2 2 RD

The following commands are available.
Add a Carriage Return (CR) code (0Dh) to the end of each command and

) Signal name Function
transmit.
Contact Epson for more details. GND Signal wire ground
TD Transmit data
RD Receive data
Cable Layouts

) ] Communications protocol
Serial connection

. * Default baud rate setting: 9600 bps
* Connector shape: D-Sub 9-pin (male)

. : * Data length: 8 bit
* Projector input port name: RS-232C

¢ Parity: None
*» Stop-bit: 1 bit

* Cable type: Crossover (null modem) cable

¢ Flow control: None



PJLink Support

PJLink was established by the JBMIA (Japan Business Machine and Information
System Industries Association) as a standard protocol for controlling network-
compatible projector's as part of their efforts to standardize projector control
protocols.

The projector complies with the PJLink Class2 standard established by the
JBMIA.

The port number used for the PJLink search function is 4352 (UDP).
You need to make network settings before you can use PJLink.

It complies with all commands except for the following commands defined
by PJLink Class2, and agreement was confirmed by the PJLink standard
adaptability verification.

http://pjlink.jbmia.or.jp/english/

* Non-compatible commands

Function PJLink command
Mute settings Image muting set AVMT 11
Audio muting set AVMT 21

* Input ports and corresponding input source number

Input port name Input source number
HDMI1 32
HDMI2 33

* Manufacturer name displayed for "Manufacture name information query”
EPSON

* Model name displayed for "Product name information query"
* EPSON QB1000B
* EPSON QB1000W


http://pjlink.jbmia.or.jp/english/

Adjusting the Menu Settings

Follow the instructions in these sections to access the projector menu system and change projector settings.

» Related Links

* "Using the Projector's Menus" p.82

* "Using the Displayed Keyboard" p.84

* "Image Quality Settings - Image Menu" p.85

* "Input Signal Settings - Signal I/O Menu" p.88

* "Projector Installation Settings - Installation Menu" p.91

* "Projector Display Settings - Display Menu" p.92

* "Projector Feature Settings - Operation Menu" p.94

* "Projector Administration Settings - Management Menu" p.95

* "Projector Network Settings - Network Menu" p.97

* "Image Quality Memory Settings - Memory Menu" p.100

* "Projector Initial Settings and Reset Options - Initial/All Settings Menu" p.101
* "Copying Menu Settings Between Projectors (Batch Setup)” p.102



Using the Projector's Menus

The projector's menu screens are displayed in black by default. All
of the instructions in this guide are explained using white screens
unless otherwise mentioned. You can change the color theme using

You can use the projector's menus to adjust the settings that control how your
projector works. The projector displays the menus on the screen. @

. . | .
Press the [Menu] button on the control panel or remote control. Menu Color in the projector’s Display menu.
You see the menu screen. Frequently L
E Image Dynamic
mage
r Mode Dynamic
Brightness 50 Rtan
Contrast 50
Color Saturation 50
Tint 50
Sharpness
White Balance
Frame Interpolation Off
Dynamic Contrast Off
Deinterlacing Off

Image Enhancement

Scene Adaptive Gamma 5
Gamma 0
RGBCMY

Reset to Defaults
Source HDMIT
Aspect Auto

Reset to Defaults

Press the up or down arrow buttons to move through the menus listed on
the left. The settings for each menu are displayed on the right.

To change settings in the displayed menu, press [Enter].

Press the up or down arrow button to move through the settings.

To return all the menu settings to their default values, select Initial/All
Settings.

When you finish changing settings on a menu, press [Esc].



Using the Projector's Menus

Press [Menu] or [Esc] to exit the menus.

§> The ™ arrow indicates that the menu contains sub items. When you turn
on a menu setting or select a specific value for it, the menu system displays
the sub items.

-(_‘ ) m_




Using the Displayed Keyboard

You can use the displayed keyboard to enter numbers and characters. Text type Details
Numbers 0123456789

Use the arrow buttons on the control panel or remote control to highlight

the number or character you want to enter and press the [Enter] button. Alphabet ABCDEFGHIJKLMNOPQRSTUVWXY
Z
abcdefghijklmnopqrstuvwxyz
Symbols V"#8% &' ()Y +,-./535<=>2@[\ ]~
I~
11234
H b|c|d
k ' I im|n

OK Cancel

% Each time you select the A/a key, the characters change between
@ upper case and lower case. Each time you select the SYM1/2 key, the

symbols enclosed by the frame change.

After entering the text, select OK on the keyboard to confirm your entries.
Select Cancel to cancel entering text.

» Related Links
* "Available Text Using the Displayed Keyboard" p.84

Available Text Using the Displayed Keyboard

You can enter the following text when using the displayed keyboard.



Image Quality Settings - Image Menu

Settings on the Image menu let you adjust the quality of your image. The Setting Options Description
available settings depend on the currently selected color mode and input source. . .
g dep Y p Sharpness Standard Adjusts the sharpness or softness of image
Frequently Used Items Image Thin Line details.
Image Colo Dynamic Enhancement Standard: enhances outlines for the
Brightness 50 Thick Line entire image; adjusts the Thin
Contrast 50 Enhancement Line Enhancement and Thick Line
Color Saturation 50 Enhancement settings as well (defaults to
Tint 50 5).
Sharpness Thin Line Enhancement: enhances
White Balance details such as hair and clothing patterns.
Ll L u Thick Line Enhancement: enhances
LD . backgrounds and larger elements.
Deinterlacing Off
Image Enhancement White Balance Color Temp. Sets the color temperature according to
Scene Adaptive Gamma 5 the color mode you selected. Higher
Gamma 0 values tint the image blue and lower
RGBCMY values tint the image red.
Reset to Defaults
Souree HOMI G-M Correction Makes fine adjustments to the color tone.
Aspect A Higher values tint the image green and
o Deti lower values tint the image red.
Custom Adjusts the individual R (red), G (green),
Setting Options Description and B (blue) components of the offset and
ain.
Color Mode See the list of Adjusts the vividness of image colors for &
available color various image types and environments. Grayscale Adjusts the red, green, blue, and
modes brightness for the selected adjustment
level.
Brightness Various levels Lightens or darkens the overall image.
available Frame Off Adjusts the smoothness of image
Interpolation movement.
Contrast Various levels Adjusts the difference between light and P Low . o
available dark areas of the image. Normal This setting is displayed only when:
i * Image Processing is set to Fine.
Color Saturation Various levels Adjusts the intensity of the image colors. High 8 8
available * Image Processing is set to Auto
(ALLM), and the current input source
Tint Various levels Adjusts the balance of green to magenta is not compatible with ALLM.
available tones in the image. @ Signal 1/O > Image Processing




Image Quality Settings - Image Menu

Setting

Options

Description

Dynamic Contrast

High Speed
Normal
off

Adjusts the projected luminance based on
the image brightness.

Deinterlacing

off
Video
Film/Auto

Sets whether or not to convert interlaced-
to-progressive signals for certain video
image types.

* Off: for fast-moving video images.
* Video: for most video images.

* Film/Auto: for movies, computer
graphics, and animation.

This setting is displayed only when:
* Image Processing is set to Fine.

* Image Processing is set to Auto
(ALLM), and the current input source
is not compatible with ALLM.

@ Signal I/O > Image Processing

Setting Options Description
MPEG Noise Reduces the noise or artifacts seen in
Reduction MPEG video.

This setting is displayed only when:
* Image Processing is set to Fine.

* Image Processing is set to Auto
(ALLM), and the current input source
is not compatible with ALLM.

@ Signal I/O > Image Processing

Super-resolution

Reduces blurring when projecting low
resolution images.

Auto Contrast

Creates a clearer and sharper image by

Image
Enhancement

Image Preset Mode

Sets the Image Enhancement options as
a batch using preset values.

Noise Reduction

Reduces flickering in images.
This setting is displayed only when:
* Image Processing is set to Fine.

* Image Processing is set to Auto
(ALLM), and the current input source
is not compatible with ALLM.

@ Signal I/O > Image Processing

Enhancement automatically adjusting the contrast of the
projected image.
Reset Resets all adjustment values on the Image
Enhancement setting to their default
settings.
Dynamic Tone On Set to On to optimize the PQ (Perceptual
Mapping Off Quantizer) curve settings based on the

brightness of the projected HDR content.

Improves visibility of dark and bright

images.

This setting is displayed only when:

* Dynamic Range is set to Auto and
Signal Status is HDR10.

* Dynamic Range is set to Auto and
Signal Status is HDR10+.

* Dynamic Range is set to HDR10/
HDR10+.

@ Signal I/O > Dynamic Range >
Signal Status




Image Quality Settings - Image Menu

Setting

Options

Description

Scene Adaptive

Various levels

Adjusts the coloring according to the

Gamma available scene, and obtains a more vivid image.
Select a large number to enhance
contrast.

Gamma -2to02 Adjusts the coloring by selecting one of

Custom the gamma correction values, or referring
to a gamma graph.

RGBCMY Various levels Adjusts the hue, saturation, and

available

brightness of each color R (red), G
(green), B (blue), C (cyan), M (magenta),
Y (yellow) individually.

Reset to Defaults

Resets all settings for the current color
mode.

Source

Displays settings saved for each input
source.
To change settings for an input source,

make sure the source is connected and
select that source.

Aspect

See the list of
available aspect
ratios

Sets the aspect ratio (width-to-height
ratio) for the selected input source.

Reset to Defaults

Resets all settings for current input
source.

Reset Image
Settings

Resets all adjustment values on the Image
menu to their default settings.

@ * The Brightness setting does not affect light source brightness. To
change the light source brightness, select the Light Output setting.

* To enjoy HDR10+ content, set Dynamic Tone Mapping to Off.

» Related Links

* "Adjusting the Image Quality" p.54

* "Available Color Modes" p.53

* "Available Image Aspect Ratios" p.51
* "Adjusting the Image Color" p.59



Input Signal Settings - Signal /0 Menu

Normally the projector automatically detects and optimizes the input signal

settings. If you need to customize the settings, you can use the Signal I/O menu.

The available settings depend on the currently selected input source.

Signal /O

Source HDMIT

Signal Format
Overscan
Color Space
Dynamic Range
Image Processing
HDMIIN EQ) Level
Reset to Defaults

EDID

HOMI Link

Reset Signal /O Settings

Auto
Auto

Fine

Installation

Test Pattern
Projection
Geometry Correction

Front/Ceiling
Paint Correction

Setting Options Description
Signal Format Video Range Sets the video range to match the setting
of input source.

* Auto: automatically sets the video
range according to the brightness
range of the current input source.

* Limited (16-235): for the brightness
range 16 to 235.

* Full (0-255): for the brightness range 0
to 255.

Overscan Auto Changes the projected image ratio to
Off make the edges visible by a selectable
4% percentage or automatically.
8%

Color Space Auto Sets the conversion system for the color
BT.709 Space.
BT.2020

source.

Blanking
High Altitude Mode Off
Setting Options Description
Source — Displays settings saved for each input

To change settings for an input source,
make sure the source is connected and
select that source.

Dynamic Range

Dynamic Range

Changes the range of dark and

bright areas in images; choose from
Auto (recommended), SDR, HDR10/
HDR10+, or HLG.

Signal Status

Displays the detected input image signal.




Input Signal Settings - Signal /0 Menu

Setting

Options

Description

Setting

Options

Description

HDR10/HDR10+
Setting

Changes the PQ (Perceptual Quantizer)
curve of the dynamic range using the
HDR PQ method.

This setting is displayed only when
Dynamic Tone Mapping is set to Off and
when:

* Dynamic Range is set to Auto and
Signal Status is HDR10.

* Dynamic Range is set to Auto and
Signal Status is HDR10+.

* Dynamic Range is set to HDR10/
HDR10+.

@ Image > Dynamic Tone Mapping

This projector has achieved HDR10+
certification under the following
conditions.

* Screen size: 100 inches

* Projection distance: 300 cm (wide)
* Color Mode: Natural

* HDRI10/HDRI10+ Setting: 3

HLG Setting

Changes the HLG (Hybrid Log Gamma)
curve of the dynamic range using the
HDR HLG method.

This setting is only displayed when Signal

Status is HLG, or Dynamic Range is set
to HLG.

Image Processing

Auto (ALLM)
Fine
Fast

Improves the response speed for images
projected at high speed.

* Auto (ALLM): automatically adjusts
the response speed according to your
projected content. This setting is
displayed only when EDID Mode is
set to Up to 4K 120Hz 40Gbps or
2560x1080(21:9).

* Fine: improves the response speed for
images by selecting Off for Frame
Interpolation.

@ Image > Frame Interpolation

* Fast: disables the Frame
Interpolation, Deinterlacing, Noise
Reduction, and MPEG Noise
Reduction settings.

@ Image > Frame Interpolation
@ Image > Deinterlacing

@ Image > Image Enhancement >
Noise Reduction

@ Image > Image Enhancement >
MPEG Noise Reduction

HDMI IN EQ Level

HDMI1
HDMI2

Adjusts the HDMI input signal level
depending on the devices connected to
the HDMI port. If there is a lot of
interference in the image, or if a problem
such as no image being projected occurs,
change the setting.

You can select the settings for individual
input sources without changing the input
source.

Reset to Defaults

Resets all settings for current input
source.




Input Signal Settings - Signal /0 Menu

Setting

Options

Description

EDID

EDID (HDMI1)
EDID (HDMI2)

Describes the display capabilities of your
projector. If images are not displayed
correctly, you may be able to display them
correctly by changing this setting.

* EDID Mode: change this setting as
necessary according to the resolution
of the image.

* HDRI10+: set to Off to display images
correctly when the connected image
source does not support HDR10+.

HDMI Link

Device
Connections

Lists the devices connected to the HDMI
ports.

This setting is only displayed when
HDMI Link is set to On.

HDMI Link

Set to On to enable the HDMI Link
features.

Power On Link

Controls what happens when you turn on
the projector or connected device.

* Off: turns oft the power link.

* Bidirectional: automatically turns on
the connected device when you turn
on the projector, and vice versa.

* Device -> PJ: automatically turns on
the projector when you turn on the
connected device.

* PJ -> Device: automatically turns on
the connected device when you turn
on the projector.

Power Off Link

Controls whether connected devices are
turned off when you turn oft the
projector.

Setting Options Description
Reset Signal I/O — Resets all adjustment values on the Signal
Settings I/O menu to their default settings.

» Related Links

* "HDMI Link Features" p.65




Projector Installation Settings - Installation Menu

Settings on the Installation menu help you set up your projector in your
installation environment.

Frequently Usec

Installation

Projection

Geometry Correction

Front/Ceiling
Point Correction

Blanking
High Altitude Mode off
Reset Installation Settings
Display
No-signal Screen Blue
Startup Screen On
Messages On
Menu Color White
Standby Confirmation On
Panel Alignment Off e
Reset Display Settings
Operation
Direct Power On Off
Sleep Mode On ~
Setting Options Description
Test Pattern Display Position Displays a test pattern to assist in
Color Isolation: R | focusing and zooming the image and
. correcting image shape (select Exit or
Color Isolation: G g 1mag pe (
press the [Pattern] button to cancel
Color Isolation: B pattern display).
Exit
Projection Front Sets the way the projector faces the screen
Rear so the image is oriented correctly.
Front/Ceiling
Rear/Ceiling

Setting Options Description
Geometry H/V-Keystone Manually corrects horizontal and vertical
Correction sides.
* V-Keystone: lets you manually correct
vertical side.
* H-Keystone: lets you manually correct
horizontal side.

Quick Corner Corrects image shape and alignment
using an on-screen display.

Point Correction Divides the projected image into a grid
and corrects the distortion by moving the
selected point of intersection from side to
side and up and down.

Blanking Top Hides an area of the projected image that

Bottom you select using the arrow buttons.

Left

Right

High Altitude On Regulates the projector’s operating

Mode Off temperature at altitudes above 1500 m.

Reset Installation — Resets all adjustment values on the

Settings Installation menu to their default
settings.

» Related Links

* "Projection Modes" p.38
* "Projector Setup and Installation Options" p.19
* "Image Shape" p.43




Projector Display Settings - Display Menu

Settings on the Display menu let you customize various projector display

features.
Frequently Usec Display
No I Sereen Blue
Startup Screen On
Messages On
Display Menu Color White
Aneration Standby Confirmation On
Uperation
Panel Alignment Off ~
Reset Display Settings
Operation
Direct Power On off
Sleep Mode On ~
Sleep Mode Timer 10 min.
Standby Mode Communication On
Indicators On
Trigger Out Off
Inv Direction Button off
Reset Operation Settings
Management
Setting Options Description
No-signal Screen [ Black Sets the screen color or logo to display
Blue when no signal is received.
Logo
Startup Screen On Set to On to display a logo when the
Off projector starts up.
Messages On Set to On to display messages such as
Off input source name, color mode name,
aspect ratio, no signal message, or high
temperature warning on your projected
image.

Setting Options Description
Menu Color Black Sets the color theme of the projector
White menu system.
Standby On Set to On to display a confirmation
Confirmation Off screen before turning off the projector.
Panel Alignment On Set to On to correct color misalignment
Off in the projected image.
Select Color Select the color to correct.

Pattern Color

Select the pattern used for correction.

Start Adjustments

Starts panel alignment.

Memory

Manages saving and loading of the color
convergence in the projected image you
have adjusted.

* Save Memory: saves your current
Panel Alignment settings to the
projector's memory (three memories
with different names are available).

* Load Memory: overwrites your
current Panel Alignment settings with
saved settings.

* Rename Memory: renames a saved
memory.

* Erase Memory: erases the selected
memory settings.

Reset

Resets all adjustment values on the
Panel Alignment setting to their default
settings.

Reset Display
Settings

Resets all adjustment values on the
Display menu to their default settings.




Projector Display Settings - Display Menu

» Related Links
* "Shutting Off the Image Temporarily" p.67
* "Adjusting the Color Convergence (Panel Alignment)" p.114



Projector Feature Settings - Operation Menu

Settings on the Operation menu let you customize various projector features.

Frequently Used Items

Color Uniformity
Log Save Destination

Batch Setup Range

Operation
Light Qutput 100 %
Direct Power On Off
Sleep Mode On ~
Sleep Mode Timer 10 min.
Standby Mode Communication On
Indicators On
Trigger Out Off
Inv Direction Button Off
Reset Operation Settings
Management
Lens Lock Off
Child Lock Off
Control Panel Lock Off

USB and Internal Memory

Language @ English
Setting Options Description
Light Output Various levels Sets the brightness for the light source.
available
Direct Power On On Set to On to turn on the projector by
Off plugging it in without pressing the power
button.
Sleep Mode On Set to On to automatically turns off the
Off projector after an interval of inactivity.
Sleep Mode Timer |1 to 30 minutes Sets the interval for Sleep Mode.
Standby Mode Communication Set to Communication On to allow
On monitoring and controlling the projector
Communication over a network when the projector is in

oft

standby mode.

Setting Options

Description

Indicators On
off

Set to Off to turn off the indicator lights
on the projector except when an error or
warning occurs.

Trigger Out oft
Power

Anamorphic Wide

Outputs a DC 12V signal at 200 mA
maximum from the 3.5 mm mini-jack
Trigger Out port whenever the projector
is turned on.

If you select Anamorphic Wide, voltage
is only output from the Trigger Out
port when the Aspect setting is set to
Anamorphic Wide or Horiz.Squeeze.

Inv Direction On
Button Off

When suspending the projector from a
ceiling, set to On to invert the operation
direction of the control panel arrow
buttons.

Reset Operation —
Settings

Resets all adjustment values on the
Operation menu to their default settings.

» Related Links
* "Turning On the Projector” p.34




Projector Administration Settings - Management Menu

Settings on the Management menu let you customize various projector
administrative features.

Frequently Used Items

Operation

Management

Ler ck
Child Lock
Control Panel Lock

Color Uniformity

Log Save Destination

Batch Setup Range

Off
off
off

USB and Internal Memory

Setting

Options

Description

Control Panel Lock

Full Lock
Except for Power
oft

Controls projector button locking to
secure the projector:

e Full Lock: locks all buttons.

* Except for Power: locks all buttons
except the power button.
* Off: no buttons locked.

You can use the remote control to control
the projector even when the buttons on
the projector are locked.

dikada il Language @ English
pet Information
s Display Status
Initial/All Settings Reset Management Settings
Network
Wired LAN Infa.
Network Settings
Reset Network Settings
Memory
Image
Lens Position
Setting Options Description
Lens Lock On Locks the focus, zoom, and lens shift
Off settings.
Child Lock On Locks the power button on the projector's
Off control panel to prevent children from

turning the projector on by accident.

This setting is only displayed when
Control Panel Lock is set to Except for
Power or Off.

Color Uniformity | Color Uniformity | Set to On to adjust the color tone balance
for the whole screen.
Adjustment Level [ Sets the adjustment level.
Start Adjustments | Adjusts the red, green, and blue color
tones individually for the selected area.
Reset Resets all adjustment values on the
Color Uniformity menu to their default
settings.
Log Save Internal Memory Sets the location in which to save error
Destination USB and Internal | and operation log files.
Memory
Batch Setup Range | All Select All to copy all of the projector
Limited menu settings using the batch setup
feature. Select Limited, if you do not
want to copy the following settings:
* EDID in the Signal I/O menu
* Network menu settings
Language Various languages | Select the language for projector menu

available

and message displays.




Projector Administration Settings - Management Menu

Setting Options Description
Information Various Displays information about the projector
information and input sources. The displayed items

vary depending on the current input
source.

Display Status — Displays the projector's status
information.

Reset Management | — Resets all adjustment values on the

Settings Management menu to their default
settings, except for the following:
¢ Language

» Related Links

* "Locking the Projector's Lens Settings and Buttons" p.72

* "Adjusting the Color Tone (Color Uniformity)" p.70

* "Copying Menu Settings Between Projectors (Batch Setup)” p.102



Projector Network Settings - Network Menu

Settings on the Network menu let you view network information and set up the Setting Options Description
projector for controlling over a network. Reset Network — Resets all adjustment values on the
Freauantly Useaters Color Uniformity Settings Network menu to their default settings.
Log Save Destination USB and Internal Memory
Batch Setup Range Attention
el ® Eogieh All of the passwords that have
Infopmation been set for the Network menu
i ki _ are also reset and you need to set
Reset Management Settings them a gain.
Network
Network Settings » Related Links
ISR S0 Reset Network Settings * "Network Menu - Network Settings Menu" p.97
Memory
Image

Lens Position

Network Menu - Network Settings Menu

Reset Memory Settings

A Settings on the Network Settings menu let you select the basic network settings.
Reset All

Firmware Update

% If the Web Control Password has not been set, a screen prompting you to
@ set a password is displayed when you save the network settings. Follow the

Setting Options Description on-screen instructions to set the password.
Wired LAN Info. Various Displays wired network status and details.
information Setting Options Description
Network Settings | — Cor?ﬁgures your projector network Projector Name Up to 16 Enter a name to identify the projector
settlflgs. See the network menu table for alphanumeric over the network.
details on the Network Settings. characters

(do notuse " *
+,/;<=>2[\]"
| spaces)




Projector Network Settings - Network Menu

Setting Options Description Setting Options Description
Web Control Up to 32 Enter a password to use when accessing IP Settings DHCP Set DHCP to On if your network assigns
Password alphanumeric the projector over the Web. (The user IP Address addresses automatically; set to Off to
characters name is EPSONWEB. No password is set Subnet Mask manually enter the network's IP Address,
(do not use * : by default.) Subnet Mask, and Gateway Address
spaces) Gateway Address | y5ing 0 to 255 for each address field.
Do not use these addresses: 0.0.0.0,
Monitor Password | Up to 16 Enter a password for performing 127.x.x, 192.0.2.x or 224.0.0.0 through
alphanumeric plain text authentication for command 255.255.255.255 (where x is a number
characters communication. from 0 to 255) for IP Address
(do not use spaces 255.255.255.255 or 0.0.0.0 through
and any symbols 254.255.255.255 for Subnet Mask, and
other than @) 0.0.0.0, 127.x.x.x or 224.0.0.0 through
255.255.255.255 for Gateway Address.
Wired LAN — See the Wired LAN menu table for wey
details. IP Address Display |On Set to On to display the IP address on the
- - Off network information screen.
Projector Control | — See the Projector Control menu table for
details.

» Related Links
* "Network Menu - Wired LAN Menu" p.98
* "Network Menu - Projector Control Menu" p.98

Network Menu - Projector Control Menu

Settings on the Projector Control menu let you select settings for controlling
the projector over a network.

Network Menu - Wired LAN Menu Setting Options Description
. . . ) Basic Control On Set to On to monitor and control the
Settings on the Wired LAN menu let you select the wired LAN settings. Off projector using Basic Control in Epson
Web Control.

Remote Password | Up to 32 Enter a password to access the
alphanumeric projector using Basic Control in Epson
characters Web Control. (The user name is
(do not use * : EPSONREMOTE. No password is set by
spaces) default.)




Projector Network Settings - Network Menu

Setting Options Description

PJLink On Set to On to enable the PJLink
Off notification function.

PJLink Password Up to 32 Enter a password for using the PJLink
alphanumeric protocol for projector control.
characters
(do not use spaces
and any symbols
other than @)

Notified IP Address | Various IP Enter the IP address to receive the
addresses projector's operating status when the

PJLink notification function is enabled.
Enter the addresses using 0 to 255 for
each address field.
Do not use these addresses: 127.x.x.X or
224.0.0.0 through 255.255.255.255 (where
X is a number from 0 to 255).
AMX Device On Set to On when you want to allow the
Discovery Off projector to be detected by AMX Device
Discovery.

Control4 SDDP On Set to On to allow device information

Off to be acquired using Control4 Simple

Device Discovery Protocol (SDDP).




Image Quality Memory Settings - Memory Menu

Settings on the Memory menu let you save and load projector settings in the Setting Options Description
rojector's memory. .
pro) ¥ Load Memory Loads saved lens adjustment values.
Frequently Used Items Color Uniformity iti
Rename Memory Renames a saved lens position entry.
Log Save Destination USB and Internal Memory
Batch Setup Range Erase Memory Deletes the saved lens position entry.
Language & English
e Reset Resets all saved lens position entries.
Display Stat :
sl i _ Reset Memory — Resets all adjustment values on the
S e o o2 oo Settings Memory menu to their default settings.
Network
' Wired LAN Info. .
Memory N » Related Links
Initial/All Se TR * "Saving Settings to Memory and Using Saved Settings " p.68

Memory

Lens Position

Reset Memory Settings |

Initial/All Settings

Reset All

Firmware Update

Setting Options Description

Image Save Memory Saves the current projector settings to the
projector's memory.

Load Memory Loads saved memory settings and applies
them to the current image.

Rename Memory | Changes the name of the memory

settings.
Erase Memory Deletes a saved memory.
Reset Resets all saved image memories.
Lens Position Save Memory Saves the focus, zoom, and lens shift

adjustments as a lens position entry.




Projector Initial Settings and Reset Options - Initial/All Settings Menu

Settings on the Initial/All Settings menu let you reset certain projector settings Reset All options
to their default values and place the projector in firmware update mode so you When you select Reset All, you see the following screen.
can update the firmware.
—
Color Uniformity
Log Save Destination USB and Internal Memory + Reset Image Settings + Reset Network Settings
Batch Setup Range + Reset Signal I/0 Settings +/ Reset Memory
Language @ ERDGN v Reset Installation Settings
Ifognation +" Reset Display Settings
Display Status " :
+~ Reset Operation Settings
Resat Management Settings
+ Reset Management Settings

Network

Wired LAN Info.
Execute
Network Settings

Initial/All Settings

Reset Network Settings

Memory

If you do not want to reset values in particular menus, deselect the check box
next to the menu name. When you are ready to reset setting values, select
Execute.

Image
Lens Position

Reset Memory Settings |

At e You cannot reset the following settings:

Al * Language
Firmware Update
Attention
Setting Options Description If you perform Reset All, all of the passwords that have been set for the Network

- menu are also reset and you need to set them again.
Reset All — Lets you select menus for resetting the uar resetand you gai

settings to default values.

» Related Links

Firmware Update | — Enters the firmware update mode and « "Updating the Firmware" p.116

ready to update firmware using the USB-
A or Service port.




Copying Menu Settings Between Projectors (Batch Setup)

After selecting the projector's menu settings for one projector, you can use the
following methods to copy the settings to other projectors, as long as they are
the same model.

* by using a USB flash drive

* by connecting a computer and projector using a USB cable

* Perform batch setup before adjusting the image settings such as

keystone distortion correction. Since image adjustment values are
also copied to another projector, the adjustments you made before
performing the batch setup are overwritten and the projected screen
you adjusted may change.

* When copying the menu settings from one projector to another, user's
logo is also copied. Do not register the information that you do not
want to share between multiple projectors as a user's logo.

* Make sure Batch Setup Range is set to Limited if you do not want to
copy the following settings:

* EDID in the Signal I/O menu
* Network menu settings

@ Management > Batch Setup Range

A\ Caution

Epson takes no responsibility for batch setup failures and associated repair costs due
to power outages, communication errors, or other problems that may cause such
failures.

» Related Links
* "Transferring Settings From a USB Flash Drive" p.102
* "Transferring Settings From a Computer” p.103

Transferring Settings From a USB Flash Drive

You can copy menu settings from one projector to another of the same model
using a USB flash drive.

%  The USB flash drive must use a FAT 16/32 format and not incorporate any
@ security function. Delete any files on the drive before using it for batch
setup or the settings may not be saved correctly.

Disconnect the power cord from the projector, and check that all of the
projector's indicators have turned off.

a Connect an empty USB flash drive directly to the projector's USB-A port.

Hold down the [Esc] button on the remote control or the control panel
and connect the power cord to the projector.

When all of the projector's indicators turn on, release the [Esc] button.

The indicators start flashing and the batch setup file is written to the USB
flash drive. When writing is finished, the projector turns off.

A\ Caution

Do not disconnect the power cord or the USB flash drive from the projector
while the file is being written. If the power cord or USB flash drive is
disconnected, the projector may not start correctly.

B Remove the USB flash drive.

% The file name for the batch setup file is PPJCONFDATA bin. If you
$ need to change the file name, add text after PPCONFDATA using

only alphanumeric characters. If you change the PJCONFDATA
section of the file name, the projector may not be able to recognize
the file correctly.



Disconnect the power cord from the projector to which you want to copy
settings, and check that all of the projector's indicators have turned off.

P4l Connect the USB flash drive containing the saved batch setup file to the

projector's USB-A port.

Hold down the [Menu] button on the remote control or the control panel
and connect the power cord to the projector.

Copying Menu Settings Between Projectors (Batch Setup)

Disconnect the power cord from the projector, and check that all of the
projector's indicators have turned off.

Connect a USB cable to the computer's USB port and to the projector's
Service port.

Hold down the [Esc] button on the remote control or the control panel
and connect the power cord to the projector.

When all of the projector's indicators turn on, release the [Menu] button. n When all of the projector's indicators turn on, release the [Esc] button.

When all of the indicators start flashing, the settings are being written. The computer recognizes the projector as a removable disk.

When writing is finished, the projector turns off.
Open the removable disk icon or folder, and save the batch setup file to the

/A\ Caution computer.

Do not disconnect the power cord or the USB flash drive from the projector

while the file is being written. If the power cord or USB flash drive is % The file name for the batch setup file is PJCONFDATA.bin. If you
disconnected, the projector may not start correctly. @ need to change the file name, add text after JCONFDATA using

only alphanumeric characters. If you change the PJCONFDATA
section of the file name, the projector may not be able to recognize

@ Remove the USB flash drive. the file correctly.

Eject the USB device (Windows) or drag the removable disk icon to the

Transferring Settings From a Computer Trash (Mac).

You can copy menu settings from one projector to another of the same model by .
connecting the computer and projector with a USB cable. Disconnect the USB cable.

The projector turns off.

%  You can use this batch setup method with the following operating system
§ versions: Disconnect the power cord from the projector to which you want to copy

o Windows 8.1 and later settings, and check that all of the projector's indicators have turned off.

* macOS 10.13.x and later
Connect the USB cable to the computer's USB port and to the projector's

Service port.



Copying Menu Settings Between Projectors (Batch Setup)

Hold down the [Menu] button on the remote control or the control panel Batch Setup Error Notification

and connect the power cord to the projector.
The projector's indicators notify you if an error occurs during a batch setup

m When all of the projector's indicators turn on, release the [Menu] button. operation. Check the status of the projector's indicators and follow the

. . . instructions described in the table here.
The computer recognizes the projector as a removable disk.

Indicator status Problem and solutions
Copy the batch setup file (PJCONFDATA.bin) that you saved to your
computer to the top level folder of the removable disk. * Laser: Orange - flashing | The batch setup file may be corrupt, or the USB flash
fast drive may not be connected correctly.

* Temp: Orange - flashing | Disconnect the USB flash drive, unplug and then plug in

% Donot fil folders other than the batch setup file to th
Rl el RS GRS GRS RESRRIER SR R B the projector's power cord, and then try again.

removable disk. fast

¢ Power: Blue - flashing Writing the settings may have failed and an error may

fast have occurred in the projector's firmware.

Eject the USB device (Windows) or drag the removable disk icon to the « Status: Blue - flashing | Stop using the projector, remove the power plug from
Trash (Mac). fast the electrical outlet. Contact Epson for help.

) * Laser: Orange - flashing

Disconnect the USB cable. fast

When all of the indicators start flashing, the settings are being written. « Temp: Orange - flashing
When writing is finished, the projector turns off. fast

A Caution

Do not disconnect the power cord from the projector while the file is being
written. If the power cord is disconnected, the projector may not start
correctly.

» Related Links
* "Batch Setup Error Notification" p.104



Maintaining the Projector

Follow the instructions in these sections to maintain your projector.

» Related Links

* "Projector Maintenance" p.106

* "Cleaning the Lens" p.107

* "Cleaning the Projector Case" p.108

* "Air Filter and Vent Maintenance" p.109

* "Adjusting the Color Convergence (Panel Alignment)" p.114
* "Updating the Firmware" p.116



Projector Maintenance

You may need to clean the projector's lens periodically, and clean the air
filter and air vents to prevent the projector from overheating due to blocked
ventilation.

The only parts you should replace are the air filter and remote control batteries.
If any other part needs replacing, contact Epson or an authorized Epson
servicer.

/\ Warning

Before cleaning any part of the projector, turn it off and unplug the power cord.
Never open any cover on the projector, except as specifically explained in this
manual. Dangerous electrical voltages in the projector can injure you severely.



Cleaning the Lens

Clean the projector's lens periodically, or whenever you notice dust or smudges
on the surface.

* To remove dust or smudges, gently wipe the lens with clean and dry lens-
cleaning paper.

* If the lens is dusty, blow off dust using a blower, and then wipe the lens.

A\ Warning

* Before cleaning the lens, turn off the projector and unplug the power cord.

* Do not use a lens cleaner that contains flammable gas. The high heat generated
by the projector may cause a fire.

Attention

* Do not wipe the lens right after you turn off the projector. Doing so could
damage the lens.

* Do not use any harsh materials to clean the lens and do not subject the lens to
any impacts; otherwise, it could be damaged.

Before cleaning the lens, open the lens shutter by gently moving it to

the side. After cleaning, close the shutter.



Cleaning the Projector Case

Before cleaning the projector case, turn off the projector and unplug the power
cord.

* To remove dust or dirt, use a soft, dry, lint-free cloth.

¢ To remove stubborn dirt, use a soft cloth moistened with water and mild
soap. Do not spray liquid directly on the projector.

Attention

Do not use wax, alcohol, benzene, paint thinner, or other chemicals to clean the
projector case. These can damage the case. Do not use canned air, or the gases
may leave a flammable residue.



Air Filter and Vent Maintenance

Regular filter maintenance is important to maintain your projector. Clean a Carefully remove the dust using a vacuum cleaner or a brush.
the air filter when a message appears telling you the temperature inside the

projector has reached a high level. It is recommended that you clean these
parts over a 5,000 hour period. Clean them more often than this if you use
the projector in an environment that is dustier than expected. (Assuming the
projector is used in an atmosphere in which airborne particulate matter is less
than 0.04 to 0.2 mg/m3.)

Attention

If regular maintenance is not performed, your Epson projector will notify you when
the temperature inside the projector has reached a high level. Do not wait until this
warning appears to maintain your projector filter as prolonged exposure to high
temperatures may reduce the life of your projector.

» Related Links
* "Cleaning the Air Filters and Intake Vents " p.109
* "Replacing the Air Filter" p.111

Cleaning the Air Filters and Intake Vents

You need to clean the projector's air filters in the following situations:
* The filter or vents get dusty.

* You see a message telling you to clean it.

n Turn off the projector and unplug the power cord.



Air Filter and Vent Maintenance




Air Filter and Vent Maintenance

Attention

* Do not rinse the air filter in water, or use any detergent or solvent to clean
it.

* Do not use canned air. The gases may leave a flammable residue or push
dust and debris into the projector's optics or other sensitive areas.

g Place the air filter in the projector as shown.
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@ Close the air filter cover and tighten the screws.

Replacing the Air Filter

You need to replace the air filter in the following situations:
* After cleaning the air filter, you see a message telling you to clean or replace it.

* The air filter is torn or damaged.
You can replace the air filter while the projector is mounted to the ceiling or

placed on a table.

n Turn off the projector and unplug the power cord.









Adjusting the Color Convergence (Panel Alignment)

You can use the Panel Alignment feature to manually adjust the color
convergence (the alignment of the red and blue colors) in the projected image.
You can adjust the pixels horizontally and vertically in increments of 0.125
pixels within a range of + 3 pixels.

* You can adjust only the red or blue color convergence. Green is the

standard color panel and cannot be adjusted.
* Image quality may decline after performing Panel Alignment.

* Images for pixels that extend beyond the edge of the projected screen
are not displayed.

n Press the [Menu] button, select the Display menu, and then press [Enter].

Freque tems Display
Image N gen Blue
Startup Screen On
Messages On
Display Menu Color White
I Standby Confirmation On
Uperation
Panel Alignment Off ~

Management
Reset Display Settings

Operation
Direct Power On Off
Sleep Mode On ~
Sleep Mode Timer 10 min.
Standby Mode Communication On
Indicators On
Trigger Out Off
Iny Direction Button Off
Reset Operation Settings
Management

a Select Panel Alignment and press [Enter].

B Select Panel Alignment and set it to On.

Display
No-signal Screen Blue
Signal /O Startup Screen On
Messages On
Menu Color White
Standby Confirmation On
Panel Alignment On Ea
Select Color R
Pattern Color R/G/B
Start Adjustments
Memary
Reset

Reset Display Settings

Operation
Direct Power On Off
Sleep Mode On Ea
Sleep Mode Timer 10 min.

Standby Mode Communication On

ﬂ Select Select Color and choose one of the following:
* R to adjust the red color convergence.

* B to adjust the blue color convergence.

Select Pattern Color and choose the grid color displayed when making
adjustments. The available color varies depending on the Select Color
setting.

* R/G/B to display the grid color in white.
* R/G to display the grid color in yellow.
* G/B to display the grid color in cyan.

B Select Start Adjustments and press [Enter].



Adjusting the Color Convergence (Panel Alignment)

Select one of the following options:

¢ Select Shift the whole panel to adjust the entire panel at the same time
and go to the next step.

* Select Adjust the four corners to adjust the corners of the panel one at
a time and go to step 10.

Use the arrow buttons on the remote control to adjust the color alignment
selected in Select Color, and then press [Enter].

Adjustment affects the grid lines in the entire screen.

g Select one of the following options:
* Select Adjust the four corners to fine-tune your adjustments.

* Select Exit to finish adjustments.

@ Use the arrow buttons on the remote control to adjust the color alignment
of the screen corner highlighted by the orange box, and then press [Enter].

m When you are finished adjusting each corner of the screen, press [Enter].

@ Select one of the following options:

¢ If your projector needs additional panel alignment, select Select
intersection and adjust. Use the arrow buttons on the remote control
to highlight the corner of any misaligned box on the screen, press
[Enter], make any necessary adjustments, and then press [Enter] again.
Repeat this step as necessary for the other intersections.

* Select Exit to finish adjustments.

If you want to save the color convergence in the projected image you have
adjusted, select Memory > Save Memory.



Updating the Firmware

When you select the Firmware Update option in the projector's Initial/All
Settings menu, the projector enters firmware update mode and is ready to
perform a firmware update using the USB-A or Service port.

» Related Links
* "Updating Firmware Using a USB Storage Device" p.116
* "Updating Firmware Using a Computer and USB Cable" p.117

Updating Firmware Using a USB Storage Device

You can update the projector's firmware using a USB storage device.

Responsibility for updating the firmware lies with the customer. If a

firmware update fails due to problems such as a power failure or
communication problems, a fee will be charged for any necessary repairs.

n Download the projector firmware file from the Epson Web site.

Copy the downloaded firmware file to the root folder (highest folder in the
hierarchy) of the USB storage device.

* The USB storage device must be formatted in FAT format.

Do not copy any other files to the USB storage device.

* Do not change the firmware's file name. If the file name is
changed, the firmware update will not start.

* Check that the firmware file you copied is the correct file for your
projector model. If the firmware file is not correct, the firmware
update will not start.

B Connect the USB storage device to the projector's USB-A port.

%  Connect the USB storage device directly to the projector. If the USB
@ storage device is connected using a USB hub, the firmware update

may not be applied correctly.

Press the [Menu] button, select the Initial/All Settings menu, and press
[Enter].

Color Uniformity
Log Save Destination USB and Internal Memory
Batch Setup Range

Language & English

Information

Display Status

Reset Management Settings

Network
Wired LAN Info.
Network Settings
Reset Network Settings
Memory
Image
Lens Position

Reset Memory Settings |

Initial/All Settings

Reset All

Firmware Update

B Select Firmware Update and press [Enter].



Updating the Firmware

B Select Yes to start the firmware update.

@, * Do not disconnect the power cord from the projector while the
firmware is updating. If the power cord is disconnected, the
projector may not start correctly.

* Do not disconnect the USB storage device from the projector
while the firmware is updating. If the USB storage device is
disconnected, the update may not be applied correctly.

All of the projector's indicators start flashing and the firmware update
starts. When the update finishes normally, the projector enters standby
status (only the power indicator is lit blue). If Direct Power On is set to

On in the projector's Operation menu, the projector turns back on again.

When the update finishes, check the Information menu in the projector's
Management menu to make sure that the Version information has been
updated to the correct firmware version.

Disconnect the power cord from the projector, and then reconnect it to
the projector. If the indicators continue to flash even after reconnecting
the power cord, remove the power plug from the electrical outlet and
contact Epson.

When all indicators flash rapidly, the firmware update may have failed.

Updating Firmware Using a Computer and USB Cable

You can update the projector's firmware using a computer and a USB cable.

@ * Responsibility for updating the firmware lies with the customer. If
a firmware update fails due to problems such as a power failure or

communication problems, a fee will be charged for any necessary
repairs.

* Your computer must be running one of the following operating systems
to update the firmware.

* Windows 8.1 (32- and 64-bit)
* Windows 10 (32- and 64-bit)
* Windows 11 (64-bit)

* macOS 10.13.x (64-bit)

* macOS 10.14.x (64-bit)

* macOS 10.15.x (64-bit)

n Download the projector firmware file from the Epson Web site.

@ * Do not change the firmware's file name. If the file name is
changed, the firmware update will not start.
* Check that the firmware file you copied is the correct file for your

projector model. If the firmware file is not correct, the firmware
update will not start.

Connect the USB cable to the computer's USB port and to the projector's
Service port.



Updating the Firmware

Press the [Menu] button, select the Initial/All Settings menu, and press On the computer, copy the firmware file to the root folder (highest folder
[Enter]. in the hierarchy) of the removable disk.

Color Uniformity

Log Save Destination USB and Internal Memory * Do not copy any other files or folders to the removable disk.

Batch Setup Range Otherwise, the files or folders may be lost.

Language & English * The projector turns oft automatically if the USB cable or the
Information power cord are disconnected before the firmware file can be
Display Status copied to the removable disk. If this occurs, perform the
Reset Management Settings procedure again.

Network
Wired LAN Info.
Network Settings Perform the steps to safely remove a USB device from the computer and

fnitialflt Settings Reset Network Settings disconnect the USB cable from the projector.

Miiony All of the projector's indicators start flashing and the firmware update

Image starts. When the update finishes normally, the projector enters standby

Lens Position

status (only the power indicator is lit blue). If Direct Power On is set to

Reset Memory Settings . . . . .
il | On in the projector's Operation menu, the projector turns back on again.

Initial/all Settings

When the update finishes, check the Information menu in the projector's

Fi Updat s :
e EREEE Management menu to make sure that the Version information has been
updated to the correct firmware version.

ﬂ Select Firmware Update and press [Enter].

@, * When all indicators flash rapidly, the firmware update may have failed.
Disconnect the power cord from the projector, and then reconnect it to
the projector. If the indicators continue to flash even after reconnecting
the power cord, remove the power plug from the electrical outlet and

B Select Yes to start the firmware update.

% Do not disconnect the power cord from the projector while the
A . o contact Epson.
firmware is updating. If the power cord is disconnected, the
projector may not start correctly. * If no operations are performed for 20 minutes in update mode, the
projector turns off automatically. If this occurs, perform the procedure
again.

All of the projector's indicators turn on and the projector enters firmware
update mode. The computer recognizes the projector as a removable disk.



Solving Problems

Check the solutions in these sections if you have any problems using the projector.

» Related Links

* "Projection Problems" p.120

* "Projector Indicator Status" p.121

* "Viewing the Status Display" p.123

* "Solving Projector Power-On or Power-Off Problems" p.126
* "Solving Image Problems" p.127

* "Solving Sound Problems" p.131

* "Solving Remote Control Operation Problems" p.132

* "Solving HDMI Link Problems" p.133

* "Solving Network Problems" p.134



Projection Problems

If the projector is not working properly, turn it off, unplug it, and then plug it
back in and turn it on.

If this does not solve the problem, check the following:
* The indicators on the projector may indicate the problem.

* The solutions in this manual can help you solve many problems.

If none of these solutions help, contact Epson for technical support.



Projector Indicator Status

The indicators on the projector indicate the projector status and let you know
when a problem occurs. Check the status and color of the indicators and then
refer to this table for a solution.

* Ifthe indicators display a pattern not listed in the table below, turn the

projector off, unplug it, and contact Epson for help.

* When the Indicators setting is set to Off in the projector's Operation
menu, all indicators are off under normal projection conditions.

—®_ ) (9 Status

— O ¥ Llaser

@ Status indicator
@ Laser indicator
@ Temp (temperature) indicator
@ On/Standby (power) indicator

Projector status

Indicator and status

Problem and solutions

Power: Lit blue
Status: Lit blue
Laser: Off
Temp: Off

Normal operation.

Power: Lit blue
Status: Flashing blue
Laser: Off

Warming up, shutting down, or cooling down.

When warming up, wait about 30 seconds for an image to
appear.

Temp: Off All buttons are disabled during warm-up, shutting down,
and cooling down.

Power: Off Standby or sleep mode.

Status: Off When you press the power button, projection starts.

Laser: Off

Temp: Off

Power: Flashing blue Preparing for monitoring and all features are disabled.

Status: Off

Laser: Off

Temp: Off

Power: Lit blue Monitoring.

Status: Off

Laser: Off

Temp: Off

Power: Flashing blue

Status: Indicator status
varies

Laser: Indicator status
varies

Temp: Flashing orange

Projector is too hot.

* Make sure that the vents and air filter are not clogged
with dust or obstructed by nearby objects.

* Clean or replace the air filter.

* Make sure the environmental temperature is not too
hot.




Projector Indicator Status

Indicator and status

Problem and solutions

Power: Off
Status: Flashing blue
Laser: Off

Temp: Lit orange

Projector has overheated and turned off. Leave it turned
oft to cool down for 5 minutes.

* Make sure that the vents and air filter are not clogged
with dust or obstructed by nearby objects.

* Make sure the environmental temperature is not too
hot.

* Clean or replace the air filter.

* If operating the projector at high altitude, set the
High Altitude Mode setting to On in the projector's
Installation menu.

* If the problem persists, unplug the projector and
contact Epson for help.

Power: Flashing blue

Status: Indicator status
varies

Laser: Flashing orange

Temp: Indicator status
varies

Laser warning.

Turn the projector off, unplug it, and contact Epson for
help.

Power: Off

Status: Flashing blue
Laser: Lit orange
Temp: Off

Laser has a problem.

Turn the projector off, unplug it, and contact Epson for
help.

Power: Off
Status: Flashing blue
Laser: Off

Temp: Flashing orange

A fan or sensor has a problem.

Turn the projector off, unplug it, and contact Epson for
help.

Power: Off

Status: Flashing blue
Laser: Flashing orange
Temp: Off

Internal projector error.

Turn the projector off, unplug it, and contact Epson for
help.

» Related Links

"Projector Feature Settings - Operation Menu" p.94

"Projector Installation Settings - Installation Menu" p.91

"Cleaning the Air Filters and Intake Vents " p.109
"Replacing the Air Filter" p.111



Viewing the Status Display

You can monitor the projector's status and view error information from the

status display.

n Turn on the projector.

g Press the [Menu] button on the control panel or remote control.

B Select the Management menu and press [Enter].

Management

Lens Lock

Child Lock

Control Panel Lock

Color Uniformity

Log Save Destination

Batch Setup Range

Language @

Information

Display Status

Reset Management Settings
Network

Wired LAN Info.

Network Settings

Reset Network Settings
Memory

Image

Lens Position

B Select Display Status and press [Enter].

Off
off
off

USB and Internal Memory

English

Press the left or right arrow buttons to view different categories of

information.

» Related Links
* "Projector Status Display Messages" p.123

Projector Status Display Messages

Categories on the status display let you view information about the projector
and its operation. See the Supplemental Guide for Display Status Menu for

details.

Status messages are available only in English.

System category: Displays the system status.

Information Description
<1/4> Displays the main status.
System Status Displays the operating status of the system.

Laser Status

Displays the operating status of the light source.

Last Event

Displays the latest warnings or errors.

Intake Air Temp

Displays the air intake temperature.

Internal Temp Lv

Displays the projector's internal temperature in five levels.

<2/4>

Displays the operation time and light source information.

Operation Time

Displays the projector's total operation time.

Laser Op. Time

Displays the total operation time of the laser light source.

<3/4> Displays the status of the current input source.
Source Displays the current source.

Signal Status Displays the identification results of signals.
Resolution Displays the resolution.

Refresh Rate Displays the refresh rate and scanning method.
ColorSamp./Depth Displays the color sampling and bit depth.




Viewing the Status Display

Information

Description

Color Space

Displays the color space.

Dynamic Range

Displays the dynamic range.

Video Range

Displays the video range.

Frame Interp.

Displays the status of Frame Interpolation.

<4/4>

Displays the status of the video/image quality.

ALLM Status

Displays the status of ALLM (Auto Low Latency Mode).

Version category: Displays the serial number and firmware version.

Information Description

Serial Number Displays the serial number.

Main Displays the main version information.
Video2 Displays the embedded software version.
Sub Displays the embedded software version.
HDMI Displays the embedded software version.
Pixel Shift Displays the embedded software version.

Network Wired category: Displays the wired network status.

Information

Description

Projector Name

Displays the name used to identify the projector when
connected to a network.

Connection Mode

Displays the connection path for a wired network.

DHCP Displays the DHCP settings.
IP Display Displays the IP address display settings.
IP Address Displays the IP address.

Information

Description

MAC Address

Displays the MAC address.

Input Signal category: Displays the signal status of the current input source.

Information Description

<1/4> -

Sync Detect(5V) Displays the detection results of signals.

Signal Status Displays the identification results of signals.
Resolution Displays the resolution.

Refresh Rate Displays the refresh rate and scanning method.
ColorSamp./Depth Displays the color sampling and bit depth.
Color Space Displays the color space.

Dynamic Range

Displays the dynamic range.

Video Range Displays the video range.

HDCP Status/Ver Displays the HDCP status and version.

Trans. Type Displays the transmission method.

Stable Time Displays the amount of operating time since the signal
changed.

<2/4> -

Signal Mode Displays the signal mode.

AVI VIC/Chk.Sum Displays the VIC code and checksum for AVI InfoFrame.

CLK-MHz/Frame-Hz

Displays the actual measurement value of the pixel clock
frequency and refresh rate.

Total-H/V

Displays the total number of pixels and lines including the
number of effective pixels and blanking.




Viewing the Status Display

Information Description

Sync Polarity Displays the sync polarity of the horizontal and vertical
sync signals.

EDID Mode Displays the EDID mode.

EDID HDR10+ Displays the EDID (HDR10+) mode.

Equalizer Level

Displays the equalizer level.

<3/4> -

Audio Type Displays the audio signal type input to the source device
from the HDMI port.

Audio Freq/Depth Displays the audio signal frequency and bit depth input to
the source device from the HDMI port.

GCP A/V Mute Displays the A/V Mute status of GCP packets.

DDC Status Displays the source device and DDC communication status.

<4/4> -

HEF-VSIF ALLM

Displays the ALLM value for HF-VSIF.

» Related Links

* "Getting the Latest Version of the Documents" p.9




Solving Projector Power-On or Power-Off Problems

Check the solutions in these sections if the projector does not turn on when you The projectors may have entered sleep mode after a period of inactivity.
press the power button or it turns off unexpectedly. Perform any operation to wake the projector. To turn off sleep mode, set

Sleep Mode to Off in the projector's Operation menu.
» Related Links

* "Solving Projector Power Problems" p.126

e s . P If the projector's light source turns off, the status indicator is flashing, and
* "Solving Projector Shutdown Problems" p.126

the temp (temperature) indicator is lit, the projector has overheated and
turned off.

Solving Projector Power Problems M Related Links

* "Projector Feature Settings - Operation Menu" p.94
If the projector does not turn on when you press the power button, try the

following steps until the problem is solved.

Make sure the power cord is securely connected to the projector and to a
working electrical outlet.

If you are using the remote control, check the batteries of the remote
control.

The projector's buttons may be locked for security. Unlock the buttons in
Control Panel Lock or Child Lock in the projector's Management menu,
or use the remote control to turn on the projector.

Vil The power cord may be defective. Disconnect the cord and contact Epson
for help.

» Related Links
* "Projector Administration Settings - Management Menu" p.95

Solving Projector Shutdown Problems

If the projector's light source turns off unexpectedly, try the following steps until
the problem is solved.



Solving Image Problems

Check the solutions in these sections if you have any problems with projected * Replace the HDMI cable with the shorter one.
images. * Make sure you selected the correct Signal Format or EDID setting in

the projector's Signal I/O menu, if available for your image source.
» Related Links

* "Solving Missing Image Problems" p.127

heck th f i :
* "Adjusting an Image that is not Rectangular” p.128 B Check the status of your video source

« "Adjusting a Fuzzy or Blurry Image" p.128 * Turn on the connected video source, and press the play button to start a
* "Fixing Partial Image Problems" p.128 video, if necessary.

* "Adjusting an Image that Contains Noise or Static" p.129 * If you are projecting from a streaming media player, make sure it is

* "Adjusting an Image with Incorrect Brightness or Colors" p.129 powered by the power supply USB cable on the projector.

* "Adjusting an Upside-down Image" p.130

. - . * Make sure the connected device meets the HDMI CEC standard. See
* "Synchronizing Image and Sound" p.130

the documentation supplied with the device for more information.

e Ifyou are projecting from a laptop computer, make sure it is set up to
display on an external monitor.

Solving Missing Image Problems

If no image is displayed, try the following steps until the problem is solved. Check the following items:
¢ Turn off the projector and the connected video source, and then turn
n Check the projector's status: them back on.
* Press the [Blank] button on the remote control to see if the image was * Set the CEC function for the connected device again and restart the
temporarily turned off. device.
* Check the status indicator to confirm that the projector is in normal * Make sure the computer's display resolution does not exceed the
operating status. projector's resolution and frequency limits. If necessary, select a

different display resolution for your computer. (See your computer

* Press the projector's power button to wake it from standby or slee
pro) p U p manual for details.)

mode. Also, check if the connected computer is in sleep mode or
displaying a blank screen saver. ¢ If the other solutions do not solve the problem, reset all of the projector

To turn off sleep mode, set Sleep Mode to OfF in the projector's settings using Reset All Config on the Initial/All Settings menu.

Operati .
peration menu » Related Links

* "Projector Feature Settings - Operation Menu" p.94

a Check the cable connection: * "Projector Initial Settings and Reset Options - Initial/All Settings Menu" p.101

¢ Make sure all necessary cables are securely connected and the power is
on for the projector.

* Connect the video source directly to the projector.



Solving Image Problems

Adjusting an Image that is not Rectangular

If the projected image is not evenly rectangular, try the following steps until the
problem is solved.

Place the projector directly in front of the center of the screen, facing it
squarely, if possible.

Adjust the image shape using the Geometry Correction settings in the
projector's Installation menu.

* Adjust the H/V-Keystone setting to correct the image shape.
@ Installation > Geometry Correction > H/V-Keystone

* Adjust the Quick Corner setting to correct the image shape.
@ Installation > Geometry Correction > Quick Corner

* Adjust the Point Correction setting to correct slight distortion which
occurs partially.

@ Installation > Geometry Correction > Point Correction

» Related Links
* "Projector Installation Settings - Installation Menu" p.91

B Clean the projector's lens.

% To avoid condensation on the lens after bringing the projector
in from a cold environment, let the projector warm up to room

temperature before using it.

Adjust the Sharpness setting in the projector's Image menu to improve
image quality.

If you are projecting from a computer, use a lower resolution or select a
resolution that matches the projector's native resolution.

» Related Links
* "Focusing the Image with the Lens Button" p.49
* "Image Quality Settings - Image Menu" p.85

Adjusting a Fuzzy or Blurry Image

If the projected image is fuzzy or blurry, try the following steps until the
problem is solved.

Adjust the image focus using the [Lens] button on the control panel or
remote control.

a Position the projector close enough to the screen.

Fixing Partial Image Problems

If only a partial image is displayed, try the following steps until the problem is
solved.

Adjust the size of the projected image using the [Lens] button on the
control panel or remote control.

Press the [Aspect] button on the remote control to select a different image
aspect ratio.

Make sure you selected the correct projection mode. You can select this
using the Projection setting in the projector's Installation menu.

If you are projecting from a computer, check your computer display
settings to disable dual display and set the resolution within the projector's
limits. (See your computer manual for details.)



Solving Image Problems

» Related Links

* "Resizing the Image with the Zoom Feature" p.48

* "Projector Installation Settings - Installation Menu" p.91
* "Changing the Image Aspect Ratio" p.51

If you connected an extension power cable, try projecting without it to see
if it caused interference in the signal.

Al If you are projecting from a computer, select a computer video resolution
and refresh rate that are compatible with the projector.

Adjusting an Image that Contains Noise or Static
g If you connected an A/V system that does not support eARC/ARC to the

If the projected image contains electronic interference (noise) or static, try the HDMI2 (eARC/ARC) port, the image may be distorted.

following steps until the problem is solved.
» Related Links

n Check the cables connecting your video source to the projector. They ) "Image Quality Se‘ttings . Image Menu 2'85
should be: * "Input Signal Settings - Signal I/O Menu" p.88

* Separated from the power cord to prevent interference

* Securely connected at both ends Adjusting an Image with Incorrect Brightness or Colors
* Not connected to an extension cable

If the projected image is too dark or bright, or the colors are incorrect, try the

a Adjust the Noise Reduction, MPEG Noise Reduction, and Deinterlacing following steps until the problem is solved.

settings in the projector's Image menu. _
Press the [Color Mode] button on the remote control to try different color

@ Image > Image Enhancement > Noise Reduction . .
modes for the image and environment.

@ Image > Image Enhancement > MPEG Noise Reduction

@ Image > Image Enhancement > Deinterlacing a Check your video source settings.

B If you adjusted the image shape using the projector controls, try B Adjust the available settings in the projector's Image menu for the current
decreasing the Sharpness setting in the projector's Image menu to input source, such as Brightness, Contrast, Tint, Color Saturation, and
improve image quality. RGBCMY.

Make sure you selected the correct Signal Format or EDID setting in the Make sure you selected the correct Dynamic Range setting in the
projector's Signal I/O menu. projector's Signal I/O menu.
Change the HDMI IN EQ Level setting in the projector's Signal I/0 B Make sure you selected the correct Signal Format or EDID setting in the

menu. projector's Signal I/O menu.



Solving Image Problems

Make sure all the cables are securely connected to the projector and your
video equipment. If you connected long cables, try connecting shorter
cables.

Position the projector close enough to the screen.

» Related Links
° I'Image Quallty Settll‘lgs - Image Menuu p85
* "Input Signal Settings - Signal I/O Menu" p.88

Adjusting an Upside-down Image

If the projected image is upside-down, select the correct projection mode.
@ Installation > Projection

» Related Links
* "Projector Installation Settings - Installation Menu" p.91

Synchronizing Image and Sound

If the projected image and the output sound are not in sync, try the following
steps until the problem is solved.

When Image Processing is set to Fine in the projector's Signal I/O menu,
set Frame Interpolation to Off in the projector's Image menu.

a Set Image Processing to Fast in the projector's Signal I/O menu.

Select the sound output settings of the video devices connected to the
projector. For details, see the documentation supplied with your video
device.



Solving Sound Problems

If there is no sound or the volume is too low, try the following steps until the
problem is solved.

Check the cable connections between the projector and your video/audio
source.

Check your video/audio source to make sure the volume is turned up and
the audio output is set for the correct source.

If you are using an eARC/ARC-compatible A/V system, check the
following items:

* Make sure your A/V system is connected to the projector's eARC/ARC
compatible HDMI port. See the Supplemental A/V Support Specification
for eARC/ARC audio supported formats.

* Make sure the cable meets the HDMI CEC standard.

* Make sure the connected A/V system meets the HDMI CEC standard.
See the documentation supplied with the device for more information.



Solving Remote Control Operation Problems

If the projector does not respond to remote control commands, try the following
steps until the problem is solved.

If you lose the remote control, you can order another one from Epson.

Check that the remote control batteries are installed correctly and have
power. If necessary, replace the batteries.

Check to see if a button on the remote control is stuck down, causing it to
enter sleep mode. Release the button to wake the remote control up.

If the image is projected from the projector, make sure you are operating
the remote control within the reception angle and range of the projector.

Check the indicators to confirm that the projector is in normal operating
status.

Strong fluorescent lighting, direct sunlight, or infrared device signals may
be interfering with the projector's remote receivers. Dim the lights or
move the projector away from the sun or interfering equipment.

» Related Links

* "Remote Control Operation" p.32

* "Installing Batteries in the Remote Control" p.31
* "Projector Indicator Status" p.121



Solving HDMI Link Problems

If you cannot operate the connected devices using the HDMI Link features, try
the following steps until the problem is solved.

n Make sure the cable meets the HDMI CEC standard.

Make sure the connected device meets the HDMI CEC standard. See the
documentation supplied with the device for more information.

B Check if the device is available in the Device Connections list.

If the device does not appear in the Device Connections list, it does not
meet the HDMI CEC standards. Connect a different device.

@ Signal I/0O > HDMI Link > Device Connections
n Check that all cables required for HDMI Link are securely connected.

Make sure the connected devices are turned on and in standby status. See
the documentation supplied with the device for more information.

If you connect a new device or change the connection, set the CEC
function for the connected device again and restart the device.

» Related Links
* "Input Signal Settings - Signal I/O Menu" p.88
* "Operating the Connected Devices Using the HDMI Link Features" p.65



Solving Network Problems

Check the solutions in these sections if you have problems using the projector
on a network.

» Related Links
* "Solutions When You Cannot Access the Projector Through the Web" p.134

Solutions When You Cannot Access the Projector
Through the Web

If you are unable to access the projector through a Web browser, make sure you
are using the correct ID and password.

* Make sure you use the following user IDs. (You cannot change the user IDs.)
* To access the Basic Control option, enter EPSONREMOTE.
* To access other options and save settings, enter EPSONWEB.

* For the password, enter the password set in the projector's Network menu.
No password is set by default.

* If your Web browser is set up to connect via a proxy server, the Epson Web
Control screen cannot be displayed. Make settings for a connection without
using a proxy server.

* Ifyou set the Standby Mode setting to Communication On in the projector's
Operation menu, make sure the network device is turned on. After turning
on the network device, turn on the projector.

The user ID and password are case sensitive.



Appendix

Check these sections for the technical specifications and important notices about your product.

» Related Links

* "Optional Accessories and Replacement Parts" p.136
* "Screen Size and Projection Distance” p.137

* "Supported Monitor Display Resolutions" p.139

* "Projector Specifications" p.140

* "External Dimensions" p.142

* "List of Safety Symbols and Instructions" p.143

* "Laser Safety Information" p.145

* "Glossary" p.148

* "Notices" p.149



Optional Accessories and Replacement Parts

The following optional accessories and replacement parts are available. Please
purchase these products as and when needed.

The following list of optional accessories and replacement parts is current as of:
May 2024.

Details of accessories are subject to change without notice and availability may
vary depending on the country of purchase.

» Related Links

* "Mounts" p.136

* "External Devices" p.136

* "Replacement Parts" p.136

Mounts

Ceiling mount ELPMB22
Ceiling mount (Low profile) ELPMB30
Use when installing the projector on a ceiling.

Safety Wire Set ELPWRO1
Use when connecting the projector to the installation mount to prevent the
projector from falling down.

Ceiling pipe (450 mm) ELPFP13

Ceiling pipe (700 mm) ELPFP14
Use when installing the projector on a high ceiling.

%  Special expertise is required to suspend the projector from a ceiling.
§ Contact Epson for help.

External Devices

Android TV" device ELPAP12
Use this streaming media player to watch online content.

Replacement Parts

Air filter ELPAF62
Use as a replacement for used air filters.



Screen Size and Projection Distance

Check the table here to determine how far to place the projector from the screen 16:9 screen size (1) ()
based on the size of the projected image. Minimam (Wide) to | Vertical Lens Shif
Y Maximum (Tele) Bottom to Top
B 80" 177 x 100 239 - 503 -146 - 46
/T* 100" 221 x 125 300 - 630 -182-58
~ 150" 332 x 187 452 - 947 -273 - 86
200" 443 x 249 604 - 1264 -364 - 115
d 250" 553 x 311 756 - 1582 -455 - 144
300" 664 x 374 908 - 1899 -547 - 173
4:3 screen size (1) (2]
Minimum (Wide) to | Vertical Lens Shift
Maximum (Tele) Bottom to Top
- 50" 102 x 76 182 - 384 -111-35
) 60" 122 x 91 219 - 462 -134 - 42
| 80" 163 x 122 293 - 617 -178 - 56
@ Projection distance (cm) 100" 203 x 152 368 - 772 -223-71
120" 244 x 183 442 - 927 -268 - 85

@ Distance from the center of the lens to the base of the screen (This changes
depending on the setting for vertical lens shift.) (cm) 150" 305 x 229 554 - 1160 334 - 106

@ Center of lens
200" 406 x 305 740 - 1548 -446 - 141
16:9 screen size (1 (2] 220" 447 x 335 814 - 1704 -491 - 155
Minimum (Wide) to | Vertical Lens Shift 244.8" 497 x 373 906 - 1896 -546 - 173
Maximum (Tele) Bottom to Top
50" 111 x 62 148 - 313 -91-29

60" 133 x 75 178 - 376 -109 - 35




Screen Size and Projection Distance

16:10 screen size (1) (2]
Minimum (Wide) to | Vertical Lens Shift
Maximum (Tele) Bottom to Top

50" 108 x 67 160 - 339 -98 - 31
60" 129 x 81 193 - 407 -118 - 37
80" 172 x 108 259 - 544 -158 - 50
100" 215 x 135 324 - 682 -197 - 62
120" 258 x 162 390 - 819 -236-75
150" 323 x 202 489 - 1024 -295-93
200" 431 x 269 653 - 1367 -394 - 125
250" 538 x 337 817 - 1710 -492 - 156
277.2" 597 x 373 907 - 1897 -546 - 173




Supported Monitor Display Resolutions

See the Supplemental A/V Support Specification for detailed information on
compatible refresh rates and resolutions for each compatible video display
format.

» Related Links
* "Getting the Latest Version of the Documents" p.9



Projector Specifications

Product name

EH-QB1000B/EH-QB1000W

Dimensions 520 (W) x 169 (H) x 447 (D) mm (not including raised
section)

LCD panel size 0.74"

Display method Poly-silicon TFT active matrix

Resolution 2,073,600 pixels

Full HD (1,920 (W) x 1,080 (H) dots) x 3

Focus adjustment

Powered

Zoom adjustment

1.0 to 2.1 (Optical Zoom)

Lens Shift

Powered
Maximum vertical direction: Approx. +96.3%

Maximum horizontal direction: Approx. +47.1%

Light source

Laser diode

Light source output
power

Upto 126 W

Wavelength 449 to 461 nm

Laser class (internal laser | Class 4

light source)

Light source operation Up to about 20,000 hours

time *

Speaker N/A

Power supply 100-240V AC£10% 50/60Hz 3.5- 1.6 A
Operating power When the light source brightness is 100%: 341 W

consumption (100 to 120
V area)

When the light source brightness is 50%: 206 W

Operating power
consumption (220 to 240
V area)

When the light source brightness is 100%: 328 W
When the light source brightness is 50%: 200 W

Standby power Communication On: 2.0 W
consumption Communication Off: 0.4 W
Operating altitude Altitude 0 to 3,048 m

Operating temperature

Altitude of 0 to 2,286 m: +5 to +35°C (Humidity of 20 to
80%, No condensation)

Altitude of 2,287 to 3,048 m: +5 to +30°C (Humidity of
20 to 80%, No condensation)

Storage temperature

-10 to +60°C (Humidity of 10 to 90%, No condensation)

Mass

Approx. 12.8 kg

* Approximate time until the light source brightness decreases to half of

its original value. (Assuming the projector is being used in an environment
containing airborne particles of 0.04 to 0.2 mg/m3. This is an approximate guide
only and may change depending on the projector’s usage and surroundings.)

This product is also designed for IT power distribution system with phase-to-

phase voltage 230V.

The rating label is attached on the bottom of the projector.

Angle of tilt

If you use the projector tilted at an angle greater than the one shown in the
following illustration, it could be damaged and cause an accident.




Projector Specifications

» Related Links
* "Connector Specifications" p.141

Connector Specifications

USB-A port 1 USB connector (Type A)

Service port 1 USB connector (Mini-B)

Trigger Out port 1 Stereo mini pin jack

LAN port 1 RJ-45

Opt.HDMI (300mA) port 1 Power supply connector for optical
HDMI cable

HDMII port 1 HDMI

HDMI2 (eARC/ARC) port 1 HDMI

RS-232C port 1 Mini D-Sub 9-pin (male)

%  USB-A and Service port supports USB 2.0. However, USB ports are not
@ guaranteed to operate all devices that support USB.




External Dimensions

@ Distance from center of lens to suspension bracket fixing point
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List of Safety Symbols and Instructions

The following table lists the meaning of the safety symbols labeled on the

equipment.
No. [ Symbol mark Approved Description
standards
(1) I IEC60417 "ON" (power)
No. 5007 To indicate connection to the mains.
(2] IEC60417 "OFF" (power)
No. 5008 To indicate disconnection from the
mains.
© I IEC60417 Stand-by
No. 5009 To identify the switch or switch
position by means of which part of the
equipment is switched on in order to
bring it into the stand-by condition.
(4] ISO7000 Caution
No. 0434B, To identify general caution when using
IEC3864-B3.1 the product.
(5) IEC60417 Caution, hot surface
No. 5041 To indicate that the marked item can
be hot and should not be touched
without taking care.
0 IEC60417 Caution, risk of electric shock
No. 6042 To identify equipment that has risk of
ISO3864-B3.6 electric shock.
(7] IEC60417 For indoor use only
No. 5957 To identify electrical equipment
designed primarily for indoor use.

No. |Symbol mark Approved Description
standards
(8] Q'C c IEC60417 Polarity of d.c. power connector
No. 5926 To identify the positive and negative
connections (the polarity) on a piece
of equipment to which a d.c. power
supply may be connected.
(5] e_@_@ — The same as No. 8.
(10) [ IEC60417 Battery, general
No. 5001B On battery powered equipment. To
identify a device for instance a cover
for the battery compartment, or the
connector terminals.
® c + IEC60417 Positioning of cell
No. 5002 To identify the battery holder itself and
to identify the positioning of the cell(s)
inside the battery holder.
® [ + — The same as No. 11.
® IEC60417 Protective earth
No. 5019 To identify any terminal which is
intended for connection to an external
conductor for protection against
electric shock in case of a fault, or the
terminal of a protective earth electrode.
(14) IEC60417 Earth
No. 5017 To identify an earth (ground) terminal

in cases where neither the symbol No.
13 is explicitly required.




List of Safety Symbols and Instructions

Symbol mark

Approved
standards

Description

/\/

IEC60417
No. 5032

Alternating current

To indicate on the rating plate that the
equipment is suitable for alternating
current only; to identify relevant
terminals.

IEC60417
No. 5031

Direct current
To indicate on the rating plate that the

equipment is suitable for direct current
only; to identify relevant terminals.

IEC60417
No. 5172

Class II equipment

To identify equipment meeting the
safety requirements specified for Class
IT equipment according to IEC 61140.

ISO 3864

General prohibition

To identify actions or operations that
are prohibited.

® O o]

ISO 3864

Contact prohibition

To indicate injury that could occur
due to touching a specific part of the
equipment.

0
X
ﬁ

Never look into the optical lens while
the projector is on.

ol
X

To indicate that the marked item don't
place anything on projector.

>

1SO3864
IEC60825-1

Caution, laser radiation

To indicate the equipment has a laser
radiation part.

No. |Symbol mark Approved Description
standards
(23] ISO 3864 Disassembly prohibition
To indicate a risk of injury, such as
electric shock, if the equipment is
disassembled.
@ ° IEC60417 Standby, partial standby

No. 5266 To indicate that part of the equipment

is in the ready status.
(25) ISO3864 Caution, movable parts

IEC60417 To indicate that you must keep away

No. 5057 from movable parts according to
protection standards.

24) IEC60417 Caution (Moving Fan Blades)
No. 6056 As a safety precaution, stay away from
the moving fan blades.
@ IEC60417 Caution (Sharp Corners)

No. 6043 To indicate sharp corners that should

not be touched.
(28] — To indicate that looking into the lens
2R hil S hibi
m while projecting is prohibited.
(29) ISO7010 Warning, Optical radiation (such as
A No. W027 UV, visible radiation, IR)

ISO 3864 Taking care to avoid injury to eyes and
skin when in the vicinity of optical
radiation.

(30) IEC60417 Not to be used in residential areas.

No. 5109 To identify electrical equipment which

is not suitable for a residential area.




Laser Safety Information

This product is a laser projector that projects images onto surfaces such as walls Laser Wa rning Labels
and screens.

This projector is a Class 1 consumer laser product that complies with the Laser warning labels are attached on the projector.
following standards:
* IEC60825-1:2014 Inside
¢ EN60825-1:2014+A11:2021
Follow these safety instructions when using the projector.
DANGER: CLASS 4 LASER RADIATION WHEN OPEN.
AVOID EYE OR SKIN EXPOSURE TO DIRECT OR
. SCATTERED RADIATION.
A Warning DANGER : EN CAS D'OUVERTURE RAYONNEMENT
LASER DE CLASSE 4. EVITER L'EXPOSITION DES
* Do not open the projector's case. The projector contains a high-powered laser. YEUX OU DE LA PEAU AUX RAYONNEMENTS
DIRECTS OU DIFFUES.
* Possibly hazardous optical radiation emitted from this product. Do not look at PELIGRO: RADIACION LASER DE CLASE 4 CUANDO

ESTA ABIERTO. EVITAR LA EXPOSICION DE OJOS O
PIEL A LA RADIACION DIRECTA O DISPERSA.

* As with any bright source, do not stare into the beam, RG2 IEC/EN 62471-5:2015. GEFAHR: LASERSTRAHLUNG KLASSE 4 WENN
GEOFFNET. BESTRAHLUNG VON AUGE ODER HAUT
DURCH DIREKTE ODER STREUSTRAHLUNG

operating light source. Eye injury may result.

A \;‘ERM#ETIDEN# SSHOKRS . BRI RS EI B AT
. B FTFA 4 JSROLIEST. WA AR B At
Caution iggﬁaffqrﬁ%aﬁ; B ) Bat. WD
D i le th i h i i fit. Di i Gz : $TF 4 CLASS 4) EH. 1 )
: 0 rllot dlsa.ssezll) e the ;;erJectlor‘w en disposing of it. Dispose according to your B AR IS B o e 5 RS
ocalor national laws and regu’ations. 1Bl WAl 4 S3 20[X HIE. DA 2 AL LAl

5= e O|E 52 O|5IAI.
BiR: CTEBEKETSR 4 DLU—UREHES,
E—LAPHENDEXFEENDHIF L Z8IFTD T &

characteristics.

@ The projector uses a laser as the light source. The laser has the following

* Depending on the surroundings, the brightness of the light source may
decline. The brightness declines a lot when the temperature gets too
high.

* The brightness of the light source declines the longer it is used. You can
change the relationship between usage time and decline in brightness
settings.

» Related Links
* "Laser Warning Labels" p.145



Laser Safety Information

Top Bottom
/A WARNING
WARNING: Never look into the lens.
AVERTISSEMENT : Ne regardez jamais dans I'objectif.
N WARNUNG: Blicken Sie niemals in das Objektiv. ( W
< -><"/D ADVERTENCIA: No mire nunca a través del objetivo. 000 —
RG2 | S5 (EBIPIE. SEHICL Y REDZDRNTL R, e Il
ZT: RS Hj A= okg BX O © © 5
Bt TEEAEL. B AZERSHA. i
A CAUTION © H
CAUTION: Do not put your finger in the moving parts of the projector's lens. 0
ATTENTION : Ne pas mettre le doigt dans les parties mobiles de I'objectif du projecteur. o © 0
A ACHTUNG: Vermeiden Sie den Kontakt mit beweglichen Teilen der Linse.
PRECAUCION: No ponga los dedos sobre las partes méviles de las lentes del proyector. 0
® | 2B L/ ATBBIISERERLS ST L, 0
Fo: =2ME A=0| FX0l= B0 7122 EX| O0IM K. 0
AR TERFRMNNSSELMER, URERYG. I
\ TE: FORFIRMARSEAFENBRAES, DRHEKkE. J 0
0° |

CLASS 1 LASER PRODUCT CONSUMER LASER PRODUCT
PRODUIT LASER DE CLASSE 1 Verbraucher-Laserprodukt

LASER KLASSE 1 EN 50689:2021

The label attached on the projector varies depending on the countries and
* Never look into the projector lens when the laser is on. This can damage your regions.
eyes and is especially dangerous for children and pets.

* When turning on the projector at a distance using the remote control, make For North/South America

sure there is no one looking into the lens.
* Do not allow small children to operate the projector. Children must be A Wa rning

accompanied by an adult. MOUNT ABOVE THE HEADS OF CHILDREN. The use of a ceiling mount is
* Do not look into the lens during projection. Also, do not look into the lens recommended with this product to place it above the eyes of children.

using optical devices, such as a magnifying glass or telescope. This could
cause visual impairment.



Laser Safety Information

Complies with FDA performance standards for laser products except for
conformance as a Risk Group 2 LIP as defined in IEC 62471-5: Ed. 1.0. For
more information see Laser Notice No. 57, dated May 8, 2019.



Glossary

This section briefly explains the difficult terms that are not explained in the text

of this guide. For details, refer to other commercially available publications.

Aspect Ratio

The ratio between an image's length and its height.

Screens with a horizontal:vertical ratio of 16:9, such as HDTV
screens, are known as wide screens.

SDTYV and general computer displays have an aspect ratio of 4:3.

HDTV

An abbreviation for High-Definition Television that refers to
high-definition systems which satisfy the following conditions:

* Vertical resolution of 720p or 1080i or greater (p =
Progressive, I = Interlace)

* Screen aspect ratio of 16:9

Contrast

The relative brightness of the light and dark areas of an image
can be increased or decreased to make text and graphics stand
out more clearly, or to make them appear softer. Adjusting this
particular property of an image is called contrast adjustment.

Interlace

Transmits information needed to create one screen by sending
every other line, starting from the top of the image and working
down to the bottom.

Images are more likely to flicker because one frame is displayed
every other line.

DHCP

An abbreviation of Dynamic Host Configuration Protocol, this
protocol automatically assigns an IP address to equipment
connected to a network.

IP Address

A number to identify a computer connected to a network.

Full HD

A screen size standard with a resolution of 1,920 (horizontal) x
1,080 (vertical) dots.

Gateway Address

This is a server (router) for communicating across a network
(subnet) divided according to subnet mask.

Progressive

Projects information to create one screen at a time, displaying
the image for one frame.

Even though the number of scan lines is the same, the amount
of flicker in images decreases because the volume of information
has doubled compared with an interlace system.

HDCP

HDCP is an abbreviation for High-bandwidth Digital Content
Protection.

It is used to prevent illegal copying and protect copyrights by
encrypting digital signals sent over DVI and HDMI ports.
Because the HDMI port on this projector supports HDCP, it can
project digital images protected by HDCP technology.

However, the projector may not be able to project images
protected with updated or revised versions of HDCP encryption.

Refresh Rate

The light-emitting element of a display maintains the same
luminosity and color for an extremely short time.

Because of this, the image must be scanned many times per
second to refresh the light-emitting element.

The number of refresh operations per second is called the
Refresh rate and is expressed in hertz (Hz).

SDTV

An abbreviation for Standard Definition Television that refers to
standard television systems which do not satisfy the conditions
for HDTV High-Definition Television.

HDMI

An abbreviation for High Definition Multimedia Interface.

HDMI is a standard aimed at digital consumer electronics
and computers. This is the standard by which HD images and
multichannel audio signals are digitally transmitted.

By not compressing the digital signal, the image can be
transferred at the highest quality possible. It also provides an
encryption function for the digital signal.

sRGB

An international standard for color intervals that was formulated
so that colors that are reproduced by video equipment can be
handled easily by computer operating systems (OS) and the
Internet. If the connected source has an sRGB mode, set both
the projector and the connected signal source to sRGB.

Subnet Mask

This is a numerical value that defines the number of bits used for
the network address on a divided network (subnet) from the IP
address.




Notices

Check these sections for important notices about your projector.
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FCC Compliance Statement

Supplier's DECLARATION of CONFORMITY
According to 47CFR, Part 2 and 15
Class B Personal Computers and Peripherals; and/or

CPU Boards and Power Supplies used with Class B Personal Computers

We: Epson America, Inc.
Located at: 3131 Katella Avenue, Los Alamitos, CA
Tel: 562-981-3840

Declare under sole responsibility that the product identified herein, complies
with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each
product marketed, is identical to the representative unit tested and found to

be compliant with the standards. Records maintained continue to reflect the
equipment being produced can be expected to be within the variation accepted,
due to quantity production and testing on a statistical basis as required by
47CFR 2.906. Operation is subject to the following two conditions: (1) this
device may not cause harmful interference, and (2) this device must accept any
interface received, including interference that may cause undesired operation.

Trade Name: EPSON

Type of Product: LCD Projector
Model: HB23B

Options:

Product name Model

Remote controller 2214345 xx (x=0-9)

FCC Compliance Statement For United States Users

This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions: (1) This device may not cause harmful interference,
and (2) this device must accept any interference received, including interference
that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed
to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this
equipment does cause interference to radio and television reception, which can
be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures.

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

* Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

* Consult the dealer or an experienced radio/TV technician for help.



WARNING

The connection of a non-shielded equipment interface cable to this equipment
will invalidate the FCC Certification or Declaration of this device and may
cause interference levels which exceed the limits established by the FCC for
this equipment. It is the responsibility of the user to obtain and use a shielded
equipment interface cable with this device. If this equipment has more than
one interface connector, do not leave cables connected to unused interfaces.
Changes or modifications not expressly approved by the manufacturer could
void the user's authority to operate the equipment.

Statement for Canadian EMC Rules

[CAN ICES-3 (B) / NMB-3 (B)]

Indication of the manufacturer and the importer in
accordance with requirements of EU directive

Manufacturer: SEIKO EPSON CORPORATION
Address: 3-5, Owa 3-chome, Suwa-shi, Nagano-ken 392-8502 Japan
Telephone: 81-266-52-3131

http://www.epson.com/

Indication of the manufacturer and the importer in
accordance with requirements of United Kingdom
directive

Manufacturer: SEIKO EPSON CORPORATION
Address: 3-5, Owa 3-chome, Suwa-shi, Nagano-ken 392-8502 Japan
Telephone: 81-266-52-3131

http://www.epson.com/

Importer: Epson (UK) Ltd.

Address: Westside, London Road, Hemel Hempstead, Hertfordshire, HP3 9TD,
United Kingdom

http://www.epson.co.uk

Importer: EPSON EUROPE B.V.

Address: Atlas Arena, Asia Building, Hoogoorddreef 5,1101 BA Amsterdam Zuidoost
The Netherlands

Telephone: 31-20-314-5000

http://www.epson.eu/

Restriction of Use

When this product is used for applications requiring high reliability/safety

such as transportation devices related to aviation, rail, marine, automotive etc.;
disaster prevention devices; various safety devices etc; or functional/precision
devices etc, you should use this product only after giving consideration to
including fail-safes and redundancies into your design to maintain safety

and total system reliability. Because this product was not intended for use

in applications requiring extremely high reliability/safety such as aerospace
equipment, main communication equipment, nuclear power control equipment,
or medical equipment related to direct medical care etc, please make your own
judgment on this product’s suitability after a full evaluation.

Operating System References

* Microsoft - Windows' 8.1 operating system



* Microsoft - Windows 10 operating system

* Microsoft - Windows' 11 operating system

In this guide, the operating systems above are referred to as "Windows 8.1",
"Windows 10", and "Windows 11". Furthermore, the collective term "Windows"
is used to refer to them all.

* macOS 10.13.x
* macOS 10.14.x
* macOS 10.15.x
* macOS 11.0.x
* macOS 12.0.x
* macOS 13.0.x

In this guide, the collective term "Mac" is used to refer to all of the operating
systems above.

Other product names used herein are also for identification purposes only and
may be trademarks of their respective owners. Epson disclaims any and all
rights in those marks.

Trademarks

EPSON is a registered trademark of Seiko Epson Corporation.
Mac, OS X, and macOS are trademarks of Apple Inc.

Microsoft, Windows, and Windows Server are trademarks or registered
trademarks of Microsoft Corporation in the United States and/or other
countries.

HDMI, the HDMI Logo and High-Definition Multimedia Interface are
trademarks or registered trademarks of HDMI Licensing Administrator, Inc.
H I

PJLink trademark is a trademark applied for registration or is already registered
in Japan, the United States of America and other countries and areas.

Intel is a registered trademark of Intel Corporation in the U.S. and/or other
countries.

Android TV is a trademark of Google LLC.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in
a retrieval system, or transmitted in any form or by any means, electronic,
mechanical, photocopying, recording, or otherwise, without the prior written
permission of Seiko Epson Corporation. No patent liability is assumed with
respect to the use of the information contained herein. Neither is any liability
assumed for damages resulting from the use of the information contained
herein.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser
of this product or third parties for damages, losses, costs, or expenses incurred
by the purchaser or third parties as a result of: accident, misuse, or abuse of this
product or unauthorized modifications, repairs, or alterations to this product,
or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's
operating and maintenance instructions.

Seiko Epson Corporation shall not be liable against any damages or problems
arising from the use of any options or any consumable products other than
those designated as Original Epson Products or Epson Approved Products by
Seiko Epson Corporation.

The contents of this guide may be changed or updated without further notice.

Copyright Attribution

This information is subject to change without notice.
© 2024 Seiko Epson Corporation
2024.5 414507700EN
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